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Introduction

SIA-Smaart® Acoustic Tools™ provides a powerful, cost-effective set of tools for
measuring and analyzing room acoustics and evaluating sound system intelligibility.
The package consists of two program modules; the Intelligibility module and the
Analysis module. The Intelligibility module allows you to measure the impulse
response of a device or room/system and calculate both quanitative acoustical values
for room analysis and objective intelligibility ratings for electro-acoustic systems. The
Analysis module is the a file-based signal analysis program that provides both time
and frequency based displays of wave file data. Both programs work with standard
Windows audio waveform files (also called wave or *.wav files) and are designed
primarily for use with impulse response data.

The SIA-Smaart Intelligibility Module

The Intelligibility module can calculate several objective speech intelligibility indices
and quantitative acoustical values from impulse response data store in Windows
wave files. The Percentage of Articulation Loss of Consonants (%ALCons), Clarity
(early-to-late energy ratio) for some number of milliseconds (e.g., C50, C35, or C7),
and both Speech Transmission Index and Rapid Speech Transmission Index (STl and
RSTI), can all be calculated from the impulse response. The Intelligibility module can
also be used to find delay times and reflections and calculate Early Decay Time
(EDT), Direct to Reverberant level, and RT60 from the same impulse response data.

The program includes its own impulse response recorder that can calculate and
record the impulse response of the system under test using either a Maximum Length
Sequence (MLS) or stimulus-independent dual Fast Fourier Transform (FFT) transfer
function technique. The MLS method requires the use of an internally generated

MLS stimulus signal. The Dual-FFT method can use pink noise or virtually any other
continuous signal (e.g., music) as a stimulus — this is the same technique used in
SIA SmaartLive ™ to find delay times. The Intelligibility module provides an internal
pink noise generator for use in dual-FFT measurements however externally generated
signals may be used as well. The Intelligibility module can also be used to analyze
impulse data from any other source as long as the data is stored in, or can be con-
verted to standard Windows wave files.

continued...



The SIA-Smaart Analysis Module

The Analysis module reads audio data stored in any standard Windows wave (*.wav)
file including impulse response files recorded in the Intelligibility module. The program
can open one or two wave files at a time and can transform time-domain data in the
wave file(s) into its frequency domain representation, using a series of Fast Fourier
Transform (FFT) calculations. Both time and frequency characteristics of recorded
signals can then be displayed, compared and analyzed a number of ways.

Like the Intelligibility module, the Analysis module is primarily designed for use in
analyzing impulse response data and includes tools to help you find reflections,
reverberation and decay information. Other possible uses for this program include
speech analysis or any application where you need to analyze the time and frequency
characteristics of recorded signals.

What's New In this Release

SIA-Smaart Acoustic Tools 4 features a completely redesigned user interface for
both the Intelligibility and Analysis modules. The new interface design is intended

to dramatically increase ease of use by reducing the complexity of on-screen control
surfaces, providing easier access to the most frequently used program features, and
making data readouts larger and easier to read. Several redundancies and inconsis-
tencies in the two program modules have also been addressed.

In the Analysis module, the “Analyze” function has been removed since the All Bands
Table in the Intelligibility module provides very similar functionality. The Intelligibility
module also uses more conventional methods of finding and calculating quantitative
acoustical values and produces more consistent and reliable results.

In the Intelligibility module, a stock set of Clarity Factor calculations for 10, 20, 50
and 80 milliseconds have been added to the All Bands Table to compensate for the
removal of the Analyze function from the Analysis module. The ExSTI calculation has
been removed since the program also calculates true STl and RSTI values and ExSTI
is not a widely used or accepted measure of intelligibility. Additionally, %ALCons
calculations are now limited to the octave band centered on 2 kHz because this is the
only band in which this measurement is conventionally performed and for which the
result is considered valid.
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Chapter 1: Getting Started

System Hardware

Recommended Configuration Minimum Configuration

* Microsoft® Windows® 95, 98 or * Microsoft® Windows® 95, 98 or
NT 4.0 (or higher) NT 4.0 (or higher)

* 166 MHz or faster Intel® Pentium® * 90 MHz or faster Intel® Pentium®
or compatible microprocessor or compatible microprocessor

e 32-64 Mb system RAM * 16 -24 Mb system RAM

* 800 x 600 x 256-color Super VGA * 800 x 600 x 256-color Super VGA
display display

* Windows-compatible sound * Windows-compatible sound
hardware with stereo line level hardware with stereo line level
input(s), 16-24 bit resolution, input(s), 16-bit resolution, 44.1 k
selectable sampling rates from and/or 48 k sampling rate capable of
5512 to 48 k, capable of full- half- or full-duplex operation

duplex operation

When installed, the program and support files require approximately 12 Mb of hard
disk space. Keep in mind that working with audio waveform (*.wav) files can use up a
lot of “real” disk space. It's not unusual for a single waveform file to require 500 kb or
more and due to the nature of the data, they don’t compress very well (if you use disk
compression software). The same is true of frequency-domain data files created by
the SIA-Smaart® Acoustic Tools™ Analysis Module.

About Sound Hardware

SIA-Smaart Acoustic Tools is designed to work with any Windows-compatible sound
device. Only the A/D and D/A portion of the computer’s sound hardware are actually
used so the software will work well with a wide variety of devices including “off-the-
shelf” sound cards for desktop machines and the built-in sound sections of most
notebook computers.

SIA-Smaart Acoustic Tools Version 4 User Guide Page 1



Chapter 1: Getting Started

Two independent external line-level input channels (typically in the form of a single,
stereo connector) are an absolute requirement for recording impulse response
measurements using the Dual-FFT method and/or for time-locked MLS recording. We
do not recommend using the microphone level inputs on most computer sound cards
for any type of measurement. For microphone measurements, an external mixer or
microphone preamp should be used with the computer’s line-level inputs. Addition-
ally, the sound hardware must be capable of full-duplex operation if you intend to use
the Intelligibility module’s internal signal generator as your stimulus signal source.

SIA-Smaart Acoustic Tools makes no use of the sound hardware’s synthesis capability
(if any). For our purposes the major differentiating factors between sound hardware
are the maximum sampling rate, sampling resolution (bits per sample) and signal-to-
noise (S/N) ratio. If your computer does not have sound hardware, lacks a line-level
input, or you feel that its existing hardware may be problematic for any other reason,
there are a number of add-on computer sound devices on the market that you can
utilize for audio input and output.

When selecting an aftermarket sound hardware device for use with SIA-Smaart,
we recommend you look for the following features and audio characteristics:

* Full-duplex (simultaneous play and record) capability
* 2independent, external line-level input channels
* 16- to 24-bit sample resolution

* Digital inputs for use with external A/D converters (optional but highly
recommended)

* User-selectable sampling rates: The Smaart Intelligibility module supports a
number of different sampling rates from 5512 up to 48 kHz. \We recommend
choosing a sound card which supports the 44.1 and/or 48 kHz sampling rates
and at least one additional sampling rate, somewhere in the range between
4 kHz and 12 kHz

Page 2 SIA-Smaart Acoustic Tools Version 4 User Guide



Chapter 1: Getting Started

External Hardware

In addition to your computer and SIA-Smaart Acoustic Tools, several pieces of
outboard gear may be required to make measurements in the field. The following is a
list of equipment you may wish to consider to complete your measurement kit:

* Measurement Microphone: \We recommend the best omnidirectional micro-
phone with the flattest frequency response you can reasonably afford. A
high-quality microphone preamp and an external phantom power supply are also
very useful additions to a measurement tool kit.

Note: A high quality sound pressure level meter with an audio output can be very
effective as a measurement microphone.

* Mixer or other level adjustment device: Although you can set relative signal
levels at the computer in many cases, it is helpful to be able to adjust signal levels
externally. Also, being able to quickly switch the signals reaching the sound card’s
inputs can greatly expedite the measurement process in many cases. A compact
mixer with quiet microphone inputs and built-in phantom power is ideal, as it puts
several pieces of “the puzzle” in one box.

* Cables and adapters: Y-cables are useful for tying the measurement system into
sound systems. Also, as most sound cards use unbalanced (2-conductor) inputs,
several sets of adapters which allow balanced to unbalanced connections may be
necessary.

SIA-Smaart Acoustic Tools Version 4 User Guide Page 3



Chapter 1: Getting Started

Installing SIA-Smaart Acoustic Tools

If you are familiar with the standard Windows software installation process, you
probably already have SIA-Smaart Acoustic Tools up and running. If not, don't worry.
It is a very straightforward procedure. All you need to do is start the automated
installer program and follow the on-screen instructions. We strongly recommend
that you close all other Windows programs, particularly any automatic anti-
virus and/or system monitor software you have running, before attempting to
install this software.

With Microsoft Windows running, place the SmaartLive/SIA-Smaart Acoustic Tools
installation CD in your CD-ROM drive. The CD menu program should open automati-
cally. If the CD menu did not start automatically (or you exited to shut down your
virus checker, double-click the My Computer icon on the Windows desktop then
right-click the icon for the CD and select AutoPlay from the pop-up menu. After the
CD menu program opens, select Install Smaart from the top level menu then click
Smaart Acoustic Tools in the submenu.

When the Welcome screen of the install wizard appears, click the Next button to
continue. On the next screen, select Install the Full Version (Serial Number Required)
and click NVext. Enter your assigned Install Name and Serial Number on the next
screen. Please note that both your Install Name and Serial Number must be
entered exactly as registered. You should have received a registration card

in the package with this manual confirming the Install Name and Serial Number
assigned for your copy of Smaart Acoustic Tools. The Install Name and Serial
Number must be typed exactly as they appear on the registration card.

Software Installation

After entering your registration information, the Install Wizard will guide you through
the remainder of the installation process. You will be prompted to choose and installa-
tion directory (folder) and given the option to install a shortcut to SmaartLive on the
Windows desktop. The installer will suggest “c:\Program Files\SIA-Smaart Acoustic
Tools” as the target disk drive and folder for the Acoustic Tools program files. You can
accept this default or select a different destination by clicking the Browse button.

Page 4 SIA-Smaart Acoustic Tools Version 4 User Guide



Chapter 1: Getting Started

If the installer detects that SmaartLive is also installed on your computer, you will be
asked if you want to have jump modifications made to establish links between
SmaartLive and Smaart Acoustic Tools. If you answer yes, it will automatically create
or modify links files for all three programs to allow jumping and passing data between
SmaartLive and the two Acoustic Tools program modules. See Setting Up Links to
Other Programs on page 26 for more information.

If you have previously installed the 30-day demonstration version of SmaartLive,

we recommend that you install the full (Standard or Upgrade) version of SmaartLive
to the same folder used for the demonstration version. This will allow the full version
the overwrite the demo during installation. If you want to install the full version to a
different drive or directory, you should uninstall the demo version using the Windows
Add/Remove Software control panel prior to installing the full version.

When you have made your selections, the installer will create the specified program
directory, copy the program and support files into it, register the programs, and create
shortcuts in the Programs submenu in the Windows Start menu and (optionally) the
Windows desktop. When the installation is complete, click the Finish button to exit
the installer.

That's it! If you were asked to restart your computer after installation was completed
you should do so before attempting to use either of the two Acoustic Tools program
modules. Otherwise you can use the software immediately. Just press the Start
button on the Windows Taskbar, click on Programs in the menu, then click on the
listing for SIA-Smaart Acoustic Tools and select either SIA-Smaart Acoustic Tools
Intelligibility or SIA-Smaart Acoustic Tools Analysis. If you experience any problems
during or after installation, refer to Appendix A of this manual, beginning on page 120,
for troubleshooting and technical support information.

Note: If you have more than one sound device installed on your system the SIA-
Smaart Intelligibility and Analysis modules will initially select the Windows default
audio input and output (Wave-in and Wave-out) devices. To change the default device
selections for either program, select Devices from the program’s Options menu and
choose the appropriate Wave-in and Wave-out devices and the sampling resolution
(bits per sample) for each on the Devices tab of the Options dialog box.

SIA-Smaart Acoustic Tools Version 4 User Guide Page 5
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Chapter 2: Intelligibility Module Functions
and Commands

Navigating in the Intelligibility Module

Eﬂnnm,wav - S1A Smaart Intelligibility

Ele “iew Options Help

44562 samples L|5| s | AcousticToolo
Peak | | Ld ([ 0.202, -32| Ln m Ln - Lr: (0.7087 sec, -33.26 dB) Analysis
0.2028 s (227' 1"), -31.85 dB Slope: -46.93 dBisec, RT60:1.29 sec Schoedes) SEETCEE

_--- —
1204 All Bands Table

I‘- !-- Om"]"s
-24 D

Band

Broadband

Amplitude Scale

Filter Set

1/3 Octave

Amplitude (dB)

1 . I
202 1] 404 0.606 0.808 1.010
Time (Seconds)

The Intelligibility module user interface is designed to put the functionality required
for the most common impulse analysis tasks literally at your finger tips by giving you
one-click access to the most commonly used functions. The use of pop-up menus and
context-sensitive dialog boxes mean you may never have to open a menu to get at all
but the most advanced features.

In many cases, simply the clicking the label or readout field for an on-screen control
or readout will allow you to access nearly any associated parameter or option you
are likely to need. Advanced users will find the high level of control and flexibility
one would expect in a truly professional measurement and analysis application
easily accessible through menu commands, hot keys, and the Options dialog box.
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Chapter 2: Intelligibility Module Functions and Commands

The following is a brief description of the basic elements that make up the Intelligibility
module program window. Detailed information on Intelligibility module displays and
functions can be found in Intelligibility Module Functions, beginning on page 10. The
section on Intelligibility Module Commands, beginning on page 29, contains complete
listing of all menu commands and options.

The Menu Bar

Fil=  “iew Optionz Help

Virtually all of the program functions that are available as on-screen controls and/or
keyboard commands are also accessible through the pull-down menus on the Menu
Bar. Menu commands also provide access to many less commonly used features.

To activate a pull-down menu from the Menu Bar, click on its name using your mouse
or hold down the [Alt] key while pressing the key corresponding to the underscored
letter in the menu name. When a menu is open, commands may be selected by
clicking on their names with your mouse or by typing the underscored letter.

Menu commands followed by ellipses (three periods...) call dialog boxes. An arrow-
head at the right of a menu item indicates that this command activates a nested
“fly-out” submenu. For explanations of Intelligibility module menu commands, please
refer to the Help file and manual sections titled Intelligibility Module Commands
beginning on page 29.

File Information

Rl Room.way _J4s562 sampies J4v1on, 1o RHIHIEEEY

This section of the Intelligibility Module window provides information about the
primary wave file currently loaded. The (Open) File button calls an Open file dialog
box allowing you to select a wave file to load. The next field to the right displays
the file name of the wave file after opening it.

Immediately to the right of the file name field are two fields that display the number
of samples in the file and the sampling rate and resolution (bits/sample) at which the
data was recorded. When a stereo wave file is loaded, the (L and R) Channel buttons
select which channel is displayed. The Record (Rec) button opens the Intelligibility
module’s Impulse recorder.

SIA-Smaart Acoustic Tools Version 4 User Guide Page 7



Chapter 2: Intelligihility Module Functions and Commands

Level Marker Coordinates

E”T IT ITM Ln - Lr: (0.7087 sec, -33.26 dB)

The second row of display fields at the top of the Intelligibility module window give
numeric coordinates for the time and amplitude positions of Ld, Lr, and Ln markers
(see Calculating Intelligibility from an Impulse Response on page 10). The first number
in each field is the time position for the corresponding marker in milliseconds followed
by the amplitude value in decibels. The readout for the Ld marker has an additional
notation indicating the polarity (P+ or P-) of the highest peak in the impulse re-
sponse. The Ld marker is normally positioned directly on the this peak clicking the
Peak button to the left of the Ld field will return it to the peak position it is moved.

The larger field on the right is a readout for either the pencil tool (see page 24) or the
relationship between the Lr and Ln markers. When a line is drawn on the plot with
the pencil tool this field displays the time and amplitude difference between the end
points of the line as well as the distance the time difference represents. When the
normal impulse response plot is displayed and no line is present, the readout area
displays the time and amplitude difference between the Lr and Ln markers.

Cursor Readout

0.2028 s (227" 1"), -31.85 dB

The readout field immediately above the main plot area on the left gives you x and
y axis coordinates for the Intelligibility module’s precision tracking cursor when the
mouse cursor is positioned over the main plot area. X-axis coordinates are given in
seconds and distance (relative to the beginning of the file). Y-axis coordinates are
given as decibels (dB) for the ETC and impulse plot when Logarithmic amplitude
scaling is selected or as percentage of full scale (based on the bits per sample at
which the wave file was recorded) for Linear scaling.

Slope Readout

Slope: 46.93 dBlsec, RT60: 1.28 sec

The Slope field immediately above the main plot to the right of the tracking cursor
readout (see above) is a readout for either the pencil tool (see page 24) or relationship
between the Lr and Ln markers (in dB scaling mode only). When a line is drawn on the
plot with the pencil tool, this field displays the S/ope of the line in dB/second, and the
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equivalent RT60 value. In dB amplitude scaling mode, when the normal impulse
response plot displayed and no line is present, the readout area displays slope and
RT60 values based on the locations of the Lr and Ln markers.

Plot Area

The largest portion of the Intelligibility module’s main window is devoted to the
display area for impulse response and ETC data plots. The plot area will appear blank
until a wave (*.wav) file is loaded or recorded. When a file is loaded, a time-domain
(time vs. energy) representation of the wave file data appears in the plot area.

Jump To Other Programs

Analysis

Clicking the button in any display mode will automatically close the Intelligibility
module while opening the Intelligibility module and loading the file that was open in
the Intelligibility module.

RAcousticTools

Clicking the Acoustic Toals logo above the Analysis button will pop up a menu that

allows you to jump to, and pass data to other programs if there are jumps defined it

imjumps.txt. See Setting up Links to Other Programs on page 26 for more information.
Display Controls

The controls to the right of the plot area in the main program window affect the
appearance of the main impulse/ETC plot and open the Intelligibility module’s second-
ary graph windows. For more information about these controls please refer to the
following topics:

* Intelligibility Graph, page 36

All Bands Table, page 38

All (Options), page 47

Amplitude Scale Commands, page 43

* (Octave and 1/3 Octave Band Filters, page 46
About Intelligibility Module Filters, page 25
Calculating Intelligibility from an Impulse Response, page 10
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Intelligibility Module Functions
Calculating Intelligibility from an Impulse Response

Rl Room.way _J4s562 sampies J4v1on, 1o RHIHIEEEY

When a wave file is opened or a new file is recorded in the Intelligibility module,

the file's raw time-domain audio data is displayed in the plot area with amplitude

on the y-axis and time on the x-axis. The file name, number of samples in the file,
and its sampling rate and resolution (8-24 bits/sample) are displayed in the file name
and information fields at the top of the Intelligibility module window. If a stereo file

is loaded, only one channel is displayed. You can switch between channels using
the L and R (left/right) channel selector buttons to the right of the file name and
information fields.

| Band

=
Broadband 2

You can select whether to display either the unfiltered broadband data or a 1- or
1/3-octave passband using the Band spinner list to the right of the plot. The available
(1- or 1/3-octave) bands in this list will depend on the currently selected .

| Amplitude Scale

Log (dB) [

Both Linear and Logarithmic (decibel) amplitude scaling are available however Log
(dB) amplitude scaling is normally used when performing intelligibility calculations.
Amplitude scaling is selected using the Amplitude Scale spinner located to the right
of the plot.

Positioning the Level Markers

In dB scaling mode three markers appear on the plot labeled Ld (Level direct), Lr (Level
reverberant), and Ln (Level noise). The time and amplitude coordinates for these three
markers are used as the basis for %ALCons and Clarity calculations. The standard STI

and RSTI calculations are not dependent on the level marker positions.
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By default, the Schroeder Inverse Integration curve is calculated and displayed above
the raw time-domain data of the impulse response. The Schroeder trace is intended
mostly as a guide to help you identify the overall trends in the impulse response. The
three level markers should normally be positioned on the impulse response trace itself.

u'----- Broadband
[ ]

A

T
A
bl

Level marker positions for fairly Level marker positions for an impulse response
a typical impulse response. with a late buildup of reverberant energy.

The Ld marker is automatically set at the position of the highest point in amplitude
value found in the time-domain trace when a file is loaded. This will normally repre-
sent the arrival of direct sound. The Lr and Ln markers must be positioned manually.
Any of the markers can be moved anywhere on the plot using your mouse. The time
and amplitude position (milliseconds, dB) for each marker are displayed in the marker
coordinate readout fields above the plot.

Peak

To calculate intelligibility values other than STl and RSTI from an impulse response,
first confirm that the Ld marker is in the correct position. If it has been moved since
the file was opened or the position is otherwise incorrect, click the (Set LD to) Peak
to return it to the highest peak in the impulse response or manually move it to the top
of the first arrival peak by dragging the marker with your mouse. The Lr marker should
then be positioned at the top of the reverberant decay slope (sometimes called the
“elbow” or “knee” of the impulse response), and the Ln and the Ln marker at the
approximate point where the decay slope meets the noise floor, sometimes referred
to as the “saddle.”

You will need to repeat this procedure for each octave or 1/3-octave band you intend
to analyze. The Intelligibility module “remembers” the marker positions for each
passband during run-time and will return the makers to the correct position for each
band as you switch between bands during a session. Please note that the marker
positions are not stored when the file is closed.
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The time and amplitude difference between the Lr and Ln markers, as well as the
distance the time difference represents, the Slope (in dB/second) and the equivalent
RT60 reverberation time are normally displayed in the slope readout and relative
cursor readout fields above the plot.

Note that you can find this same information for any two points on the plot by holding
down the [Shift] key as you click and “drag” (move the mouse while holding down the
left mouse button) the mouse cursor across the plot to draw a line. While the line

is present, the information in the slope readout and relative cursor readout fields is
calculated relative to the end points of the line, rather than the Lr and Ln markers.
Clicking once on the plot while holding down the [Shift] key erases the line. See
Finding Time and Amplitude Differences on page 24 for more details.

The All Bands Table

All Banids Table

After positioning the level markers, for the passbands you want analyze, you can click
the All Bands Table button to display a table of reverberation and decay characteristic,
Clarity values and %ALCons (if applicable) for multiple octave- or 1/3-octave pass-
bands. The All Bands Table will include all bands in the current filter set that have
been displayed since the current file was opened.

All Bands Table
Band |_RT60 | EDT | DTR | ZMeonslS)| %Aleons(L]] €35 | C10 | c20 | c50 | ceo |
Broadband 134 037 29 = " 780 714 7ES 783 802
B3 Hz 133 078 4 = " 691 822 7E2 435 207
125 Hz 125 125 10 = - 202 250 208 18 105
250 Hz 107 057 21 = - 207 146 183 216 289
500 Hz 132 073 14 g s 083 015 073 087 115
1 kHz 112 08 17 - . 097 195 A1 092 06D
2kHz 114 045 23 225 250 687  GO7 G674 BA0D 702
4 kHz 117 036 27 = - 1044 1000 1037 1048 1069
8 kHz 047 029 EE = - 1357 1166 1339 1362 1383

Frrint | Cloge |

The Intelligibility dialog box and the All Bands Table both have a Save button that
allows you to export the values to an ASCII file for import into other applications or
documents. Both can also be printed directly from the Intelligibility module.
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The Intelligibility Graph

Intelligibility |

Clicking the Intelligibility button opens the Intelligibility dialog box. This window
displays the results intelligibility calculations, and several quantitative acoustical
values. With the exception of STl and RSTI, all of the values displayed in this window
apply only to the passband currently displayed in the main program window.

Intelligibility - D:\Program Files\SIA Smaart Acoustic Tools\Waves\...

EAD FOOR FaIR GOOD  EXCELLENT
2801 2185

Zalkcons | T T T T — —T T
680 335 195 115 65 38 22 12

.87
C35 | T T T T T T T d
4 B B [1} 3 [ 9 12 18
064 R 0.72

STI

} T T T — —1 T T {
0z 03 04 05 06 07 08 08 1.0

RTED: I 1.28  Sec  Claity: [35 ms -
Early Decay Time: I 041 Sec STI I 072 2kHz il
Direct to Reverb: I FER -} RSTI: I 0E4

CalGulee eTlene BoTi| Save. |

The Intelligibility dialog window is “mode-less,” meaning you can leave it open while
you continue to work in the main program window. When you move the marker
positions on the main plot, values displayed in the Intelligibility dialog window update
themselves automatically (where applicable) to reflect changes as they are made. All
of the information shown in the Intelligibility graph window can be saved to an ASCII
text file suitable for import into a spreadsheet or other applications by clicking the
Save button at the bottom of the window.

Intelligibility Scales

The top half of the Intelligibility dialog box is devoted to the Intelligibility Graph. In this
section, objective intelligibility values are plotted on three horizontal scales ranging
from “Bad” to “Excellent” (left to right). Separate scales are provided for three types
of intelligibility values:

* Percentage Articulation Loss of Consonants (%ALCons)
* Clarity (early-to-late energy ratio) at n milliseconds (Cn)
* Speech Transmission Index (STI) and Rapid Speech Transmission Index (RSTI)
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Values for the current measurement are indicated by yellow “flags” plotted on these
three scales. Two of the scales have two “sub-types” so there are separate flags for
each. The results for both the long and short forms of the %ALCons calculations are
plotted on the %ALCons scale with the type indicated on the individual flags by the

letters “L” for long form and “S” for short form. Note that %ALCons will appear only
after setting the Ld, Lr, and Ln markers in the 1-octave passband centered on 2 kHz.

Two different values will appear on the ST/ scale after running the STl calculation
routine: STl and Rapid STI (RSTI). The latter is indicated by a flag with the letter “R”
after the number. The STl and RSTI calculations require fairly significant processing
time so they are calculated only upon request when you click the Calculate STI and
RSTI button. Once calculated, these values will not change for a given file. Their
values are not dependent upon the level markers or the Band (broadband or passhand)
currently selected for display.

Other Quantitative Acoustical Values

The lower section of the Intelligibility dialog box is devoted to display fields for some
additional acoustical values and controls for the Clarity scale and display passband.

RT60 — RT60 or “reverberation time” is an expression of the reverberant decay
rate of the system under test. By convention, reverberation time is expressed as the
amount of time it would take the system to decay 60 dB at the given rate of decay
(RT60). The decay rate is determined from the relative positions of the Lr and Ln
markers on the plot in the main program window. The value shown in this field
applies only to the Band (broadband or passband) currently selected for display.

Early Decay Time — This is an expression of the rate at which the system under
test completes earliest stage of its decay. This value is dependent on the relationship
between the Ld and Lr markers on the main plot and applies only to the Band (pass-
band) currently selected for display. As with RT60, the early decay time is expressed
as the amount of time (in seconds) that would be required for the signal to decay 60
decibels at the given rate of decay.

Direct to Reverh — The direct-to-reverberant level. This is the relative difference
between the level of direct sound to the level of reverberant energy at the top of the
reverberant decay slope. This value (given in decibels) is simply the difference in level
between the Ld and Lr markers however it is an important factor in the overall intelligi-
bility of a room/system.
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Clarity — The Clarity field sets the number of milliseconds used for the Clarity Factor
scale in the upper portion of the window. For example, entering 35 in this field will set
the clarity scale to C35.

STl and RSTI — The STl and RSTI fields show the calculated Speech Transmission
Index values after running the Calculate STl and RSTI routine. Note that STl and RSTI
values are calculated only when you click the Calculate STI and RSTI button. These
calculations can take some time to process, particularly on long files, so they are done
only on demand. This only needs to be done once for any file, however. The STl and
RSTl values are not dependent on either the positions of the level (Ld, Lr, and Ln)
markers or the passband currently selected for display.

Band — The Band selector serves the same function as the Band selector to the right
of the plot in the main program window. It selects the passband for both the Intelligi-
bility window and the main impulse response plot— either the unfiltered Broadband
data or a 1- or 1/3-octave passband as determined by the filter set currently in use.

Recording an Impulse Response
MLS or Dual-FFT?

The first decision you will need to make before recording an impulse response
measurement is which recording technique to use. The Intelligibility module’s Record
Impulse feature allows you to acquire the impulse response of a room/system under
test using a Maximum Length Sequence (MLS) or dual Fast Fourier Transform (Dual-
FFT) transfer function technique. MLS and Dual-FFT are basically just two different
ways of comparing what goes into a system with what comes out. There are,
however, fundamental differences between the two techniques.

MLS is a single-channel, stimulus-dependent measurement technique that requires
the use of an internally generated IMLS stimulus signal. Since the stimulus signal is
known, only the output of the system under test needs to be recorded (hence the term
“single-channel”). Dual-FFT is a dual-channel, stimulus-independent measurement
technique that can use virtually any continuous signal, including pink noise (recom-
mended for most acoustic/intelligibility measurement applications) or music, as a
stimulus. This technique requires that you capture both the stimulus signal and the
output of the system under test during the measurement procedure. Each of these
two approaches has its advantages.
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The MLS Method

Of the two techniques, MLS has the potential to offer somewhat superior noise
rejection. Since the MLS stimulus signal is pseudo-random, not random, the stimulus
is a precisely known quantity and may be easier to correlate with the measured
system response. When using MLS to acquire an impulse response, the signal
returned from the device or system under test is compared to the original, internally
generated data sequence exactly as sent to the system under test. The MLS stimulus
signal also has a lower crest factor than truly random noise so clipping the measure-
ment system’s Analog-to-Digital (A/D) converter is s little less of a concern.

Some possible disadvantages with MLS are the high concentration of energy in the
top octaves and that this method is probably a little more demanding in terms of the
computer’s audio input/output (I/0) hardware. For MLS measurements, the computer
sound hardware needs to be capable of full duplex operation (playing and recording
simultaneously) and it is more critical that the analog I/0 stages and D/A and A/D
conversion process be as transparent as possible. Since the measured signal is
compared directly to the original (digital) MLS data, it is unavoidable that some part
of what you end up measuring will be the quality of the I/0 hardware in the measure-
ment system itself (i.e., the computer and sound hardware). Also, since the MLS
stimulus signal is more “white” than pink noise, you need to exercise greater care to
avoid damaging the high-frequency elements of loudspeaker systems under test.

Note that the MLS technique can be used with or without an external loopback on
one audio I/0 channel as a time reference (see diagram on page 18). Due to a limita-
tion of Microsoft Windows, the loopback is required to accurately measure the delay
time through the system under test when using MLS. This loopback signal is used
only as a time reference and should not be confused with the reference signal in
Dual-FFT measurements.

The Dual FFT Method

The Dual FFT impulse recording technique is stimulus-independent. The Intelligibility
module provides an internal pink noise generator for use with the Dual-FFT impulse
response recorder but virtually any continuous test signal generated inside or outside
the computer may be used. In a Dual-FFT measurement, a test signal is split, prefer-
ably outside the computer, with one branch returning directly to one computer audio
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input as a reference. The other branch is sent through the system under test and the
output of the system is returned to a second computer audio input as the measure-
ment signal (see diagrams on pages 20 and 21). These two signals are then compared
in the frequency domain using a transfer function calculation and the results are
converted back to the time domain for display and analysis.

Since both the reference and measurement signals travel through the same processes
(analog I/0 stages, A/D and D/A) leaving/entering the measurement system, the Dual-
FFT technique can be more forgiving of less-than-perfect computer sound hardware.
This technique can also be used with half-duplex sound hardware (capable only of
playing or recording at any one time) provided an external test signal source is used.

The relative disadvantage of the Dual-FFT method is that it is typically necessary

to average the measurement over a longer period of time to approach the kind of
signal-to-noise ratios possible with MLS. This method also requires much more
processing power than MLS (less of an issue now than in the past) and is theoretically
less repeatable since the test signal is a more random quantity. In practice, you can
obtain very solid, repeatable measurement results using either recording method

and it is even possible to combine the two by using an MLS stimulus with the
dual-FFT method.

Recording an Impulse Response Using MLS

The Maximum Length Sequence (MLS) technique for measuring the impulse response
of a system is stimulus-dependent, requiring the use of an MLS stimulus signal. An
MLS signal is “pseudo-random,” generated using a system of bit-shift registers and

a known group of “seed” numbers. Since the output of the system under test is
compared to MLS data generated internally by the Intelligibility module, it is critical
that the stimulus signal matches the internally generated data precisely.

It is not an absolute requirement that you use the Intelligibility module’s internal

MLS signal generator. Any two MLS stimulus signals of identical length, generated
at the same sampling rate and resolution using identical seed numbers, should be
identical. And in practice, most MLS generators do, in fact, use the same seed
numbers however there is no accepted standard that says they must. Using the
internal MLS generator is probably the easiest way to be absolutely sure the stimulus
signal and program's internal MLS reference parameters are identical.
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Microphone E

Loudspeaker
Computer System Under Test
Preamp/ —— — Amplifier

e Lo
Power - Hlololele;
== Right— e=—+
Supply 1 1
External Loopback
(Optional)

The diagram above shows a typical measurement system setup for MLS measure-
ment. Note that the use of an external loopback, connecting one of the computer
outputs to one of the inputs, is optional. The loopback is required (due to a limitation
in Microsoft Windows) only as a time reference if you need to know the delay time
through the system under test. You can make an MLS measurement that is valid

in of every other respect without a loopback. When recording without a loopback,
the initial peak in the impulse response, indicating the arrival of direct sound at

the measurement microphone position, will be positioned arbitrarily at 10 or 100
milliseconds, depending on the MLS length.

e |

To begin the recording process, open the Intelligibility module and click the Record
(Rec) button. When the Record Impulse dialog box appears, click the MLS tab at the
top of the dialog box to display the MLS recording controls.

MLS: Setting Measurement Parameters

If you will be using the internal MLS generator to make your measurement, set the
Level control in the MLS Signal Generator section to a low number initially. Set the
Generate Channel(s) control to match the computer’s line output channel you are
using to send the stimulus signal to the system under test or choose Stereo to send
the signal on both output channels. If you are using the external loopback option, the
Generate Channel(s) will be set automatically to Stereo.
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In the Impulse Output File field, you can type the path and file name for the wave file
to be used to store the measurement results or click the Browse button and use the
Open file dialog box to navigate to the desired folder and specify a file name. If you
will be using an external loopback as a time reference for the measurement, make
sure the Use Loopback for Time Alignment check box is checked. Set the Measure-
ment Channel selector to match the computer line input used for your measurement
microphone/preamp. Notice that when the Use Loopback for Time Alignment option
is checked, the Reference Channel is automatically set to the opposite channel.

When the Averages value is set to a number greater than 1, multiple MLS data
sequences are recorded and the results are averaged together to produce the finished
measurement. Each doubling of the number of averages will yield 3 dB more signal to
noise in the finished measurement however the time required to make each measure-
ment is increased. As a general rule, you will want to use higher numbers of averages
in noisier environments and/or when you are restricted to using lower sound pressure
levels to stimulate the room/system under test.

The sampling rate (SR) determines the frequency content of the completed measure-
ment. To measure the full audio spectrum, a sampling rate of 44.1 k or greater is
required. Using lower sampling rates will restrict the highest frequency obtainable

to one half of the sampling rate (the Nyquist frequency).

The MLS Length, together with the sampling rate, determines the Time Constant of
the sequence, also called the “time window.” The Time Constant for the selected MLS
Length and SR values is automatically displayed below the MLS Length field. To obtain
a solid impulse response measurement, the NILS time constant must be longer
than the decay time of the system under test.

As a general rule, a time window of .7 to 1.5 seconds is sufficient for most small- to
mid-sized rooms. Larger rooms with longer decay times require a longer time window.
When in doubt, it never hurts to go too long — in fact, it will help to improve the
signal-to-noise ratio of the measurement. This does, however, increase both the time
required to make the measurement and the resulting wave file size. Larger files will
take more time to filter and analyze. If you find you have overestimated when the
measurement is completed, you may want to use the X Zoom feature and Save As
command to edit out some of the unneeded “noise tail.”
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MLS: Recording the Impulse Response

If you are using the internal MLS Signal Generator, click the Generate MLS Signal
button to begin sending a signal and carefully bring the Level control up to desired
signal level. Remember that the MLS signal is essentially white noise with most of
its energy in the higher octaves. You need to exercise care not to overdrive high-
frequency drivers in the loudspeaker system being used to stimulate the room. Note
that you may also need to set the overall Wave output level in the Windows Volume
Control to achieve the desired output level.

Adjust the measurement microphone preamp gain and/or the computer’s Line-In level
in the Windows Recording Control if necessary so that the measurement signal and
loopback signal (if applicable) are running at about —12 dB on the /nput Meters and
click the Record button. The Intelligibility module will record audio data based on you
measurement parameters, process the data and write the results to the specified
output file. When the recording process is completed the Record Impulse dialog box
closes automatically and the new file is displayed in the main Plot Area.

Recording an Impulse Response Using Dual FFT

The Dual FFT impulse response measurement technique is stimulus-independent.
This technique can be used with internally or externally generated pink noise
(recommended for most acoustical measurement applications) or virtually any
other continuous signal (e.g., music) as a stimulus.

Measurement ‘9
Microphone

Loudspeaker
Computer System Under Test
Preamp/ ﬁ Amplifier
rranon | e 9%
Power « Right— o
Supply

Reference Signal

Dual FFT measurement setup using the internal signal generator
(requires full-duplex capable computer sound hardware).
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When using this recording method, a test signal is split, normally outside the com-
puter, with one branch returning directly to one computer audio input as a reference
signal. The other branch is sent through the system under test and the output of the
system is returned to the other input as the measurement signal.

Microphone E

Preamp/
Phantom Loudspeaker
Power
Suppl
PPY — Computer System Under Test
Signal —— Amplifier
Source In Out
.

Reference Signal
Dual FFT measurement setup using an external signal source.

The diagram above shows a typical measurement system setup for Dual FFT mea-
surement using the internal signal generator as the reference signal source. The
diagram below shows a Dual-FFT measurement setup using an external signal source.

e |

To begin the recording process, open the Intelligibility module and click the Record
(Rec) button. When the Record Impulse dialog box appears, click the Dual FFT tab at
the top of the dialog box to display the Dual FFT recording controls.

Dual-FFT: Setting Measurement Parameters

If you intend to use the internal signal generator to make your measurement, set
the Level control in the Pink Noise Generator section to a low number initially. In the
Impulse Output File field, you can type the path and file name for the wave file to be
used to store the measurement results or click the Browse button and use the Open
file dialog box to navigate to the desired folder and specify a file name.

When the Averages value is set to a number greater than 1, the specified number of
FFT frames are recorded and processed and the results averaged together to produce
the finished measurement. Each doubling of the number of averages will yield 3 dB
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better signal-to-noise in the finished measurement however the time required to
make each measurement is increased. As a general rule, you will want to use higher
numbers of averages in noisier environments and/or when you are restricted to using
lower sound pressure levels to stimulate the room/system under test.

The sampling rate (SR) determines the frequency content of the completed measure-
ment. To measure the full audio spectrum, a sampling rate of 44.1 k or greater is
required. Using lower sampling rates will restrict the highest frequency obtainable

to one half of the sampling rate (the Nyquist frequency).

The FFT size, together with the sampling rate, determines the FFT Time Constant,
also called the “time window.” The FFT Time Constant for the selected FFT Size and
SR values is automatically displayed below the FFT field. To obtain a solid impulse
response measurement, the FFT time constant must be longer than the decay
time of the system under test.

As a general rule, an FFT time constant of .7 to 1.5 seconds is sufficient for most
small- to mid-sized rooms. Larger rooms with longer decay times require a longer time
window. When in doubt, it never hurts to go too long — in fact, it will help to improve
the signal-to-noise ratio of the measurement. It does, however, increase both the time
required to make the measurement and the resulting wave file size. Larger files will
take more time to filter and analyze. If you find you have overestimated when the
measurement is completed, you may want to use the X Zoom feature and Save As
command to edit out some of the unneeded “noise tail.”
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Dual-FFT: Recording the Impulse Response

If you are using the internal Pink Noise Generator, click the Generate Pink Noise
button to begin sending a signal and carefully bring the Level control up to desired
level. Note that you may also need to set the overall Wave output level in the Win-
dows Volume Control to achieve the desired output level. If you are using an externally
generated signal, start sending signal to the system under test and the computer. In
either case, adjust appropriate external gain controls and/or the computer’s Line-In
level in the Windows Recording Control as necessary so that the reference signal is
running at about -12 dB on the Input Meters. Make sure the reference signal is being
received on computer’s Left input channel (indicated by the blue meter “LEDs" on the
right) and the measurement signal from the microphone is on the Left input (indicated
by the green meter “LEDs" on the left).

Adjust the measurement microphone preamp gain if necessary so that both the
reference and measurement signals are running at about —12 dB on the Input Meters
and click the Record button. The Intelligibility module will record audio data based on
your measurement parameters, process the data and write the results to the specified
output file. When the recording process is completed the Record Impulse dialog box
closes automatically and the new file is displayed in the main Plot Area.
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Finding Time and Amplitude Differences

Ln - Lr: [0.7087 sec, -33.26 dB)

In decibel (dB) amplitude scaling mode, the time and amplitude difference between
the Lr and Ln markers on the impulse response plot, the S/ope (in dB/second) and the
equivalent RT60 reverberation time are normally displayed in the slope readout and
relative cursor readout fields above the plot. The Intelligibility module has another
feature that allows you to find this same information, as well as the distance the time
difference represents (given the speed of sound), for any two points on the plot in any
display mode.

Slope: 46.93 dBlsec, RTE0: 1.28 sec

f If you press the [Shift] key on your keyboard while the mouse cursor is positioned

+ over the main plot, the mouse cursor changes to a tiny pencil. If you hold down the
[Shift] key while “dragging” the cursor (moving the mouse while holding down the
left mouse button) across the plot, you will draw a line on the plot. While the line is
present on the plot, the information in the Relative Cursor Readout is calculated
relative to the end points of the line, rather than the Lr and Ln markers. Clicking once
on the plot while holding down the [Shift] key will erase the line.

A Shortcut for Positioning the Ld, Lr, and Ln Markers

3 Notice that if you press the [Alt] key while the mouse cursor is positioned over the
k plot, the cursor mouse changes to a marker symbol with a plus sign in the center.
Clicking the left mouse button while holding down the [Alt] key moves the selected
level marker to the mouse cursor location.

You can select the (Ld, Lr, or Ln) markers using the [Tab] key or by simply clicking a
marker with your mouse. You can also move the markers around on the plot using
the arrow keys or by clicking on a marker and dragging it (moving the mouse while
holding down the left mouse button) from one place to another. For more information
on setting the Ld, Lr, or Ln) markers refer to Calculating Intelligibility from an Impulse
Response on page 10.

Page 24 SIA-Smaart Acoustic Tools Version 4 User Guide



Chapter 2: Intelligibility Module Functions and Commands

Zooming With the Mouse

() Your computer’s mouse (or other pointing device) can be used to set both the time (x-

A axis) and amplitude (y-axis) ranges on the main Intelligibility module plot. Notice that
if you press the [Ctrl] key on your keyboard while the mouse cursor is positioned over
the main plot, the mouse cursor changes to a magnifying glass with a plus sign in the
center. If you click on the plot while the [Ctrl] key is depressed, the plot will zoom in on
both the x and y axes by a preset increment centered on the cursor location. Clicking
and “dragging” (holding down the left mouse button while moving the mouse) while
holding down the [Ctrl] key will draw a “rubber band” box on the plot. When the
mouse button is then released, the area enclosed by the box will be expanded to the
full x and y limits of the plot.

=l When you press the [Ctrl] and [Shift] keys simultaneously, the mouse cursor changes
Y 0o magnifying glass with a minus sign in the center. If you click on the plot while the
[Ctrl] is depressed, the plot will zoom out on both the x and y axes by a preset incre-
ment, centered on the cursor location. To reset the time (x-axis) range of the plot to
the full time range of the wave file and the amplitude (y-axis) range to the default
range as specified on the Graph tab of the Options dialog box, click once with your
mouse anywhere in the margins of the plot or press the [Home] key.

About Intelligibility Module Filters

| Filter Set

|
1£3 Octave =

All filtering in the SIA Intelligibility module is performed in the time domain. The
program comes with a set of 1- and 1/3-octave digital (FIR) filters. Filter sets are
selected using the Filter Set spinner to the right of the main plot. The passhand is
then selected from the Band spinner (shown below) or using the Band list box in the
Intelligibility dialog window. The individual bandpass filters are stored in ASCII text
format to allow advanced users to make change the stock filters or write their own.
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I Band

|
Broadband =

The ASCII filter files are kept in the Filters sub-directory (folder) in the main program
folder. The Intelligibility module creates its lists of available filters each time you start
the program based on the information in another text file called “filterfiles.txt,” also
located in the Filters folder. This file contains a list of the individual filter file names and
other information about each file such as the sampling rate, filter type, and list name.

In addition to the 1/1 and 1/3-octave filters “types,” there is also a provision for a
third, “User” filter type. User filters (if present) are made available from the Band
spinner whether the 1-octave or 1/3-octave filters sets are selected. The Intelligibility
module accepts either FIR or lIR time-domain filters. For more information on custom-
izing the filter lists, please refer to the instructions included in filterfiles.txt.

Setting up Links to Other Programs

RcousticTools

In addition to the built-in links between the Intelligibility and Analysis modules (see
Analysis on page 30 and Intelligibility on page 70), both SIA-Smaart Acoustic Tools
program modules can be configured to start and pass Wave (*.wav) or ASCII (*.txt)
data files to many other programs automatically using their jump function. The
Acoustic Tools jump function is configured by a pair of text files named wrjumps.txt
and imjumps.txt.

The wrjumps.txt file defines jumps for the Analysis module and imjumps.txt defines
jumps for the Intelligibility module. Both programs scan the SIA-Smaart Acoustic
Tools System folder on start-up to look for these files. If the program’s jump file exists
and has one or more jumps configured, its jump function is enabled automatically.
When the jump function is enabled, clicking on the Acoustic Tools logo that appears
in the upper right corner of the main program window will pop up a jump menu.

The Acoustic Tools System folder is located in the Acoustic tools program folder. The
default location of this folder is: c:\Program Files\SIA-Smaart Acoustic Tools\System.

Note that wrjumps.txt and imjumps.txt are created automatically by the Acoustic
Tools installer if SmaartLive was detected on the computer during installation and
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you answered yes when the installer asked if you wanted to make jump modifica-
tions. Otherwise, you can easily create and/or edit the wrjumps.txt and imjumps.txt
files yourself using any ASCII text editor such as the Windows Notepad.

The example of a Smaart Acoustic Tools jump definition shown below would create
a command labeled “Excel” in the jump menu for the Intelligibility or Analysis module
if added to wrjumps.txt and imjumps.txt. When selected from the jump menu, this
command would open MicroSoft® Excel® and load the last ASCII text file saved by
the program into a new Excel worksheet.

[Excel]

PATH=c:\Program Files\Microsoft Office\Office\Excel.exe

ARGS=

EXIT=N

SMAART=N

WAVE=N

TEXT=Y

Each jump must begin with a section title enclosed in brackets that will also become
provides the text label for its jump menu command in Intelligibility or Analysis module
pop-up jump menu. The PATH line must provide the complete path and file name of

the target program. The ARGS line can be used to pass additional command line
arguments to the target application if necessary.

The remaining lines are yes or no questions that should have either a “Y” or “N” after
the equals sign (=) as follows:

* [f EXIT=Y, the Smaart program you are jumping from shuts down as it starts the
target program.

* The SMAART line is for use when jumping between Smaart Acoustic Tools and
SmaartLive (4.1 or higher) and should be set to “N" for jumps to other programs.

* |[f WAVE=Y, the Smaart program you are jumping from will pass a wave file it has
open (File 1 only in the Analysis module) to the target application. This line should
be set to “N” if the TEXT line is set to “Y.”

* [f TEXT=Y, the last text file saved by the Smaart program you are jumping from will
be passed to the target program. This line should always be set to “N” if WAVE=Y.
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Making a Screen Capture

Microsoft Windows has a feature built in that allows you to capture the active
window as a bitmap. These captured “screen shots” are an easy way to include
Smaart data displays as illustrations in reports and other documents.

To make a screen shot, click on the window you want to capture with your mouse to
make sure it is the “active window" and press [Alt] + [PrtScrn] (also be labeled as
F13 on some keyboards). This copies an image of the active window to the Windows
clipboard. The image on the clipboard can be pasted directly into some word proces-
sor and spreadsheet applications, others may require you to save the image as a
bitmap file first and then import the file into the document.

To save the captured image as a bitmap using the Paint program included with
Windows, open the program by clicking the Start button on the Windows Taskbar and
selecting Programs > Accessories > Paint. In the Paint program select Paste from the
Edit menu or press [Ctrl] + [V] to bring in the image from the clipboard. If you see a
message saying that the image is too large and asking if you want to enlarge the
bitmap, click Yes. Then, while the pasted image is still selected, open the Edit menu
and select Copy To. In the Copy To dialog box navigate to the folder where you want
to put the file, type a file name, and click the Save button.

Note: All SIA-Smaart applications let you set up your own display and printing Color
Schemes. This feature can be very useful when working with screen shots. For
example, you can set up a Color Scheme with white as the background color and dark
traces to optimize the captured image for printing to a black and white printer. Color
Schemes are accessible through the Colors tab of the Options dialog box in both the
Intelligibility and Analysis.
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File Menu Commands

Open

File Menu > Open

Keyboard Command = [Ctrl] + [O]

File | Room.wav 44562 samples H ﬂ ﬂl

Clicking the File button in the upper left corner of the main Intelligibility module
window or selecting Open from the File menu calls the Open file dialog box allowing
you to select standard Windows audio waveform (*.wav) file, also called a “wave”
file, to be opened for analysis. Note that the standard Windows dialog box that has
been modified to show the sampling rate, resolution (8 - 24 bits/sample), type (stereo
or monaural), and the length (in samples and seconds) of the file you select.

If a stereo file is loaded, only one channel is displayed. You can switch between
channels using the L and R (left/right) channel selector buttons to the right of the
file name and information fields or the Channel commands in the View menu.

Save As

File Menu > Save As
Keyboard Command = [Ctrl] + [S]

This command calls a modified Windows Save As file dialog box, allowing you to
create a new wave (*.wav) file or a batch of files based on the wave file currently
loaded in the Intelligibility module. The top portion of the dialog box has the normal
areas for entering a file name and selecting the target directory for the new file. The
lower portion of the Save As dialog box offers additional options.

On the lower right of the Intelligibility module’s Save As dialog box is a pair of “radio
buttons” to select whether you want the new file to include the entire time range of
the original file or just the time range currently displayed on the main Intelligibility
module plot. On the lower left is a list box labeled Bands to Save with a listing of all
available filters. To the left of each entry in the Bands to Save list is a check box. You
can select whether to save the unfiltered (Broadband) data, a filtered version of the
original data, or some combination by checking and un-checking these boxes.
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When you save the unaltered broadband wave file data, the name for the new file will
be the file name entered on the File Mame line in the upper portion of the dialog box.
Filtered versions are named automatically using the specified File Name plus a single
letter indicating the filter type (“o” for octave, “t" for 1/3-octave, or “u” for user) and
the filter name (in parentheses). For example, if you entered “room.wav” in the File
Name field and chose to save the broadband data plus filtered versions for the octaves
centered on 250 Hz, 500 Hz, and 1 kHz (using the stock 1-octave bandpass filters),

you would create the following files:

room.wav (the unfiltered broadband data)

room_o(250 Hz).wav (the original data filtered for the octave centered on 250 Hz)
room_o(500 Hz).wav (the original data filtered for the octave centered on 500 Hz)
room_o(1kHz).wav (the original data filtered for the octave centered on 1 kHz)

Analysis

File Menu > Analysis

Analysis

This command opens the SIA-Smaart Acoustic Tools Analysis module, automatically
loading the same wave file currently that is open in the Intelligibility module. Since
neither program normally alters the wave file in any way, it is not a problem for the
two programs to have the same file open at the same time. The Analysis module
allows you to transform the wave file data into the frequency domain, using a series
of Fast Fourier Transform () calculations, and display both time- and frequency
characteristics several different ways. For more information about the Analysis
module, please refer to the Analysis module section of your SIA-Smaart Acoustic
Tools User’'s Manual or the Analysis module help file.
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Record Impulse

File Menu > Record Impulse

Rec |
Keyboard Command = [Ctrl] + [R]

This command opens the Record Impulse dialog box where you will find controls for
the Intelligibility module’s impulse response recorder. The impulse response recorder
allows you to measure the impulse response of the room/system under test using
either a Maximum Length Sequence (MLS) or stimulus-independent dual Fast Fourier
Transform (FFT) transfer function technique.

The Record Impulse dialog box has two pages or “tabs;” a Dual-FFT tab and an MLS
tab. Each tab has it’s own signal generator controls and input level meters. You will
need to specify measurement parameters and an output file name for the impulse
response data. The impulse response is written to a standard Window wave (*.wav)
file. When you have selected your measurement parameters, click the record button.
The intelligibility module will record and process data based on your selections, write
the measurement results to the specified file name, and then close the dialog box and
load the new file automatically. The measurement parameter controls on each tab are
very similar but not identical.

The Dual FFT Tab —
Recording an impulse response using the Dual o
FFT method is identical to the technique used [Cmerriiae] Lot [ 2]®
to measure delays in the SIA SmaartLive so if
you are familiar with SmaartLive, you probably [onin e s i s |
already know how to use this feature. The 2
interface is different but the measurement s Elte.E

.. . sh[anm 7] rar
procedure is identical. | IE 8 F
Pink Noise Generator — At the top of the Dual FET Tine Carsiant: 7631ms IE f IE
FFT tab are controls for the Intelligibility module’s 44
internal pink noise generator. This section con- 4o
tains a Level selector that sets the output gain _Bese | e
in dB and a Generate Pink Noise button that starts
and stops the signal generator. Use of the internal e |
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signal generator is optional as the Dual FFT recording method is stimulus-independent
and works with virtually any type of continuous test signal including music.

Impulse Output File — This is where you specify the name of the wave file to be
used to store the measurement results. You can type the path and file name for the
output wave file in the text entry field or click the Browse button and use the Open
file dialog box to navigate to the desired folder and specify a file name or select an
existing file to overwrite.

Averages — This value determines the number of FFT frames the Intelligibility
module will record. If a value greater than 1 is selected, the specified number of
frames are recorded and then averaged together to calculate the impulse response.
With every doubling of the number of the number of frames averaged, the signal-
to-noise (S/N) ratio of the measurement will increase by 3 dB (the lower limit being
the noise floor of the measurement system or the system under test, whichever

is higher). The trade-off is that it takes longer to record and process the data for
the measurement.

SR — Sets the sampling rate to be used to record the impulse response. This value
determines the frequency content of the measurement. The highest frequency
obtainable at a given sampling rate (the Nyquist frequency) will be equal to one

half of the sampling rate. As a general rule, you will probably want to use a sampling
rate of 44100 or greater to obtain a full-bandwidth impulse response. A lower rate
might be preferable when measuring a subwoofer system, a band-limited system,
or a room/system with a decay time significantly longer than five to six seconds.

FFT (size) — This value specifies the size (in samples) of the Fast Fourier Transform
(FFT) used in the impulse response calculations. Together with the Sampling Rate,
the FFT size determines the length of the FFT Time Constant or “time window" for
the measurement as well as the size of the resulting wave file.

FFT Time Constant — The time window or length of time covered by an individual
FFT Frame. This value is not directly editable as it is a function of the selected FFT
size and Sampling Rate (FFT Size divided by Sampling Rate = FFT Time Constant).
It is very critical that the FFT Time Constant be longer than the total decay time of
the room/system under test.
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The MLS Tab
Dual FFT HLS |
The MLS recording method is a single-channel, WS Ser e
stimulus-dependent measurement technique that Levet [28 = &8
Generate Channel(s): |Steen 7
compares the me_asured data to an MLS data e
sequence stored internally. The measurement
i . Impulse Dutput File
parameters for MLS recording are substantially [ fevv smaat acoutc ookt || o
similar those for the Dual FFT Method but the % Lise Loopback ForTine Algpment -8
H' H Reference Channel: Right I Cip &
MLS tab has a few additional options. emern et o] rar
MLS Signal Generator — The use of the internal g [T 0 sl
: S . sifr = 0 el
signal generator is again optional but in the case — o
of MLS, it is the simplest way to ensure that the Tie Gt 25720 e
stimulus signal exactly matches the internal MLS o
. . . Recon Input Meters
data used in calculating the impulse response of o | ’

the system under test. The MLS Signal Generator -
section includes a Level selector that sets the

output gain in dB, a Generate Channel(s) selector used to set the output channel(s),
and a Generate MLS Signal button that starts and stops the signal generator.

Impulse Output File — Specifies the name of the file to be used to store the mea-
surement results.

Use Loopback For Time Alignment — Due to a limitation in Microsoft Windows,
the Intelligibility module cannot, through software alone, determine the start time

of the MLS stimulus signal accurately enough to provide the delay time through the
system under test reliably. But since MLS is a single-channel technique, this limitation
can be worked around by routing the signal from the unused computer audio output
back to the unused input (see diagram on page 18) as a time reference. This check
box should be checked when using an external loopback connection. When recording
without a loopback signal, the initial peak in the impulse response will be positioned
arbitrarily at 10 or 100 milliseconds, depending on the MLS Length.

Reference Channel — The input channel used to record the external loopback
signal (if applicable). This parameter cannot be set directly. When the Use Loopback
For Time Alignment box is checked, the Reference Channel is set automatically to
the channel not used as the Measurement Channel, e.g., setting the Measurement
Channel to Left automatically sets the Reference Channel to Right.
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Measurement Channel — Sets the input channel to be used to record the output
of the system under test.

Averages — Setting this value to a number greater than 1, causes the Intelligibility
module to record and average the results of multiple MLS stimulus sequences to
produce the finished measurement. Each doubling of the number of averages will
yield 3 dB more signal to noise in the finished measurement (the lower limit being the
noise floor of the measurement system or the system under test, whichever is higher)
however the time required to make the measurement is increased.

SR — Sets the sampling rate to be used to record the impulse response measure-
ment. Again, the highest frequency obtainable at a given sampling rate will be equal
to one half of the sampling rate (the Nyquist frequency).

MLS Length — Like the FFT size parameter on the Dual FFT tab, this value specifies
the size (in samples) of the MLS stimulus sequence. Together with the sampling rate,
the MLS Length determines the size of the Time Constant or “time window" for the
measurement as well as the size of the resulting wave file.

Time Constant — The time window for the impulse response measurement. This
value is not directly editable but is a function of the selected FFT size and Sampling
Rate (MLS Length divided by Sampling Rate = Time Constant). As with Dual FFT
measurements, this value should always large compared to the total decay time

of the room/system under test.

Create Impulse From File

File Menu > Create Impulse From File
Keyboard Command = [Ctrl] + [F]

The Create Impulse From File feature allows you to acquire the impulse response of a
system from recorded data. You can use this feature to compare signals stored in two
separate wave files or the Left and Right channels of a single stereo wave file.
Possible uses for this feature might include:

* Applications where you need to acquire data without a computer
* Analyzing previously recorded data you already have on hand

* Situations where the amplifier room, or control room for a system is too far from
the area you need to measure to return the measured signal to the computer
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The Create Impulse From File function can use either the Dual-FFT method or MLS to
calculate an impulse response. For the dual-FFT method the choice of test signals can
be very flexible. For example, you could use a segment of a track from a music CD, a
pink noise or other test signal track from a reference CD or a wave file sent through
the system under test from a computer and then recorded remotely. The only real
requirements are that the measurement file (or track) must be recorded using the
same signal used to create the reference file and that the signal used has enough
energy at the frequencies you need to measure. The reference file will be the “dry”
signal as sent to the system under test. The measurement file will be the same signal,
recorded after traveling through the system. When two separate files are used, they
must also be recorded at the same sampling rate.

The MLS method uses only one wave file (the measurement file) and compares it to
internally generated MLS data. This technique can yield very good results however
there are a couple of important caveats that you should be aware of when using it.
First, the MLS data used to record the measurement file must be identical in length

to the internally generated sequence selected for comparison and generated using

an identical group of seed numbers. Any two MLS stimulus signals of identical length,
generated at the same sampling rate, using identical seed numbers should be identi-
cal. And in practice, many MLS generators do, in fact, use the same seed numbers
however there is no accepted standard that says they must.

The second issue, when using the MLS technique, is that to obtain the best results,
sampling rates should be consistent throughout the signal generation, output and
recording processes. If you want to be absolutely safe on both counts, use the
Intelligibility module’s internal MLS signal generator (accessible through the MLS
tab of the Record Impulse dialog box) to create your MLS stimulus signal. You can
connect the computer directly to the system under test or record the internally
generated signal to CD or DAT through a digital output. Be careful to note the
sequence length and output the signal at a sampling rate supported by the CD

or DAT recorder.

For best results, use a digital recording device to record the output of the system

under test. If you plan to bring the measured signal back into the computer digitally,
it should be recorded at the same sampling rate used to generate the MLS stimulus
signal. If you will be bringing the signal back in through an analog input, it should be
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recorded at the same sampling rate or higher. In either case, the measurement wave
file should be recorded at the same sampling rate as the original stimulus signal.

If all this is starting to sound too complicated, don’t worry. You can also obtain very
good measurement results using MLS data with the dual-FFT technique. All you need
is a wave file with the original MLS signal recorded at the same sampling rate and
resolution as the measurement data file.

Intelligibility Graph

File Menu > Intelligibility Graph

Intelligibility

Keyboard Command = [Ctrl] + [I]

This command opens the Intelligibility dialog box where the results of all intelligibility
calculations, the Intelligibility module supports are displayed. This dialog box is
“mode-less,” meaning you can leave it open while you continue to work in the main
program window. Changes to the marker positions on the main plot are applied to the
calculated values automatically (where applicable) as they are made.

The top half of the dialog box is the Intelligibility Graph where quantitative intelligibility
values are plotted on three horizontal scales ranging from “Bad” to “Excellent” (left to
right). Separate scales are provided for %ALCons, Clarity and STI.

Note that the results of two different forms of the %ALCons (long and short) calcula-
tions and two types of STl results may be plotted on these two scales. Also note that
%ALCons will appear only after setting the Ld, Lr, and Ln markers in the 1-octave
passband centered on 2 kHz ant that STl and RSTl values are calculated only when
you click the Calculate STl and RSTI button. Once calculated, STl and RSTI values
will not change for a given file.

The lower section of the Intelligibility dialog box has controls for some of the
parameters that affect the intelligibility calculations and display fields for additional
quantitative acoustical values. With the exception of ST/ and RSTI (if calculated) the
acoustical values shown in this area apply only to the Band (passband) currently
selected for display.

* RT60 — Also called “reverberation time.” RT60 is the amount of time it would take
the system to decay 60 dB at the given rate of decay (RT60).
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* FEarly Decay Time — The Early Decay Time (EDT) is rate at which the system
under test completes earliest stage of its decay, again expressed as the amount of
time (in seconds) that would be required for the signal to decay 60 decibels at the
given rate of decay.

* Direct to Reverb — The direct-to-reverberant level (DTR). This is the relative
difference between the level of direct sound to reverberant energy (at the top of the
reverberant decay slope).

* Calculate STl and RSTI — Clicking this button will cause the Intelligibility module
to calculate STl and RSTI from the impulse response data. These calculations can
take some time to process, particularly on long files, but this only needs to be done
once for any file. The STl and RSTI calculations are not dependent on either the
positions of the level (Ld, Lr, and Ln) markers or the passband currently selected
for display.

* Clarity — The Clarity field sets the number of milliseconds used for the Clarity
Factor scale in the upper portion of the window. For example, entering 35 in this
field will set the clarity scale to C35.

» ST/ and RSTI — When the STl and RSTI values are calculated for the current
file, the results of the calculations are displayed in these two fields and on the
STl scale in the upper portion of the dialog box. Again, the STl and RSTI values
are not dependent on either the positions of the level (Ld, Lr, and Ln) markers or
the passhand currently selected for display.

* Band — The Band selector serves the same function as the Band spinner to the
right of the plot in the main program window. It selects the passhand — either
the unfiltered Broadband data or a 1- or 1/3-octave passband — displayed on the
impulse response plot. The currently in use determines the available passbands.
The filter set is selected using the Filter Set spinner to the right of the plot in the
main window.

» Save — This button opens a Save As file dialog box allowing you to save all of
the intelligibility and acoustical values above to a standard ASCII text file suitable
for import into a spreadsheet, word processor, or any other application that
accepts ASClI files. If you check the Save All Bands table in the Save As dialog,
the Intelligibility will automatically create a separate text file for each passband
in the currently-selected filter set.
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All Bands Table

File Menu > All Bands Table

All Banids Table

Keyboard Command = [Ctrl] + [B]

This command opens the All Bands Table dialog box. This window lists quantitative
acoustical and intelligibility values for the broadband data and multiple octave or 1/3-
octave (depending on the filter set currently in use) passhands. The quantities listed in
this table are all based on some combination of the level (Ld, Lr, and Ln) marker
positions so only bands that have actually been displayed for the current file during
the current Intelligibility module session will be included in the table. Bands are added
to the All Bands Table automatically as you change the passband for the main display
and set or confirm the marker positions.

The All Bands Table lists (from left to right) the RT60, Early Decay Time (EDT), Direct-
to-Reverberant level (DTR), %ALCons short (S) and long (L) forms (for the 2 kHz
octave band only), the user-selected Clarity factor (Cn) and additional Clarity values
for 10, 20, 50 and 80 milliseconds (C10, C20, C50 and C80). Note that the Intelligibil-
ity Graph can show you most of these same values (with the exception of the last four
Clarity columns) for a single passband. The All Bands Table provides an easy way to
compare these values for different passbands.

Below the text table are three buttons labeled Print, Save and Close. Clicking the Print
button will, by default, take you to the Custom Print Information dialog box to allow
you to set title text and other options for the printout before printing. If you have un-
checked “Show this dialog before printing” either in the Custom Print Information
dialog box or the Printing tab of the Options dialog box, the Print button will take you
directly to the Print dialog box.

The Save button opens a Save As file dialog box to allow you to dump the information
in the table to a standard ASCII text file suitable for import into a spreadsheet, word
processor or other application. Note that the standard Windows file dialog box has
been modified to allow you to enter a text Comment to be included in the output file.
The Close button closes the All Bands Table dialog box.
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Set All Values to Default

File Menu > Set All Values to Default

The user-definable options for the Intelligibility module are very flexible and can
sometimes be confusing, especially at first. The Intelligibility module stores the state
of nearly all of these options when you exit the program so if a problem does arise,
chances are good that it will still be there the next time you start the program.

Any time you wish to restore the Intelligibility module to its “factory” default settings,
select Set All Values to Default from the File menu. This will reset all virtually user-
definable program parameters to their original default states. The only exceptions are
that the Color Scheme and device selections are left as set on the Colors and Devices
tabs of the Options dialog box.

Print

File Menu > Print
Keyboard Command = [Ctrl] + [P]

The Print command first takes you to the Custom Print Information dialog box to allow
you to set title text and other options for the printout before printing. The Custom Print
Information dialog box can be used to set all the same printing options as the Printing
tab of the Options dialog box. After setting title and page options, click the OK button
in the Custom Print Information dialog. A standard Windows Print dialog box will then
open to allow you to select a printer and set up your printer options before sending the
document to print.

Note: If you un-check either the “Show custom print dialog before print and print
preview” check box on the Printing tab of the Options dialog box or the check box
labeled “Show this dialog before print and print preview"” in the Custom Print Informa-
tion dialog box, both the Print and Print Preview commands (see next page) will
bypass the Custom Print Information dialog box and take you directly to the Print
dialog box.
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Print Preview

File Menu > Print Preview

The Print Preview command first takes you to the Custom Print Information dialog
box to allow you to set title text and other options for the printout before proceeding.
When you click the OK button in the Custom Print Information dialog box, the Intelligi-
bility goes to Print Preview mode to show you “what-you-see-is-what-you-get”
(WYSIWYG) preview of how the printed page should look. You can then use the

Print button to send the document to the currently selected printer immediately and
exit Print Preview mode or select Close to return to the normal Intelligibility module
program window without printing the document.

Print Setup
File Menu > Print Setup

The Print Setup command opens a standard Windows Print Setup dialog box where
you can select a printer and set up the page size, orientation, and paper source for
hard copy output. Depending on the type of printer selected, there may be additional
options you can access by clicking the Properties button in the Print Setup dialog.
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View Menu Commands
Zoom

Zoom Out To Limits

View Menu > Zoom > Zoom Out To Limits
Keyboard Command = [Home]

This command returns the time (x-axis) range of the main plot to the full time range of
the wave file and resets the amplitude (y-axis) range to the default range as specified
on the Graph tab of the Options dialog box. A shortcut for this command is to simply

click once with your mouse anywhere outside the plot in the margins of the plot area.

Undo / Redo Zoom

View Menu > Zoom > Undo / Redo Zoom

Keyboard Commands:
Undo Zoom = [Ctrl] + [Z]
Undo Zoom = [Ctrl] + [A]

As you zoom in and out on the main plot, the Intelligibility module remembers each
zoom view and allows you to browse back and forth through the previous views using
these two commands.

Zoom X In / Out

View Menu > Zoom > Zoom X In/ Out

Keyboard Commands:
Zoom X In = [Ctrl]] + [Down Arrow]
Zoom X Out = [Ctrl]] + [Up Arrow]

These two commands increase or decrease the horizontal (x-axis) “magnification”
by decreasing the displayed time range of the main plot. Note that you can also zoom
in on both the x and y axes of the plot and zoom out using your mouse. For more
information on this feature, please refer to the topic titled Zooming With the Mouse
in the Shortcuts section.
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Move Range Left / Right

View Menu > Zoom > Move Range Left / Right

Keyboard Commands:
Move Range Left = [Ctrl] + [Left Arrow]
Move Range Right = [Ctrl]] + [Right Arrow]

When you are zoomed in on the horizontal (x-axis) range of the main plot, only a
portion of the wave file's full time range is displayed. These two commands move
the displayed range left or right to allow you to view the information before or
after the range currently displayed.

Zoom Y In / Out

View Menu > Zoom > Zoom Y In/ Out

Keyboard Commands:
ZoomYIn =[]
Zoom Y Out = [+]

These two commands increase or decrease the vertical (y-axis) “magnification” by
decreasing the displayed amplitude range of the main plot. Note that you can also
zoom in on both the x and y axes of the plot and zoom out using your mouse. For more
information on this feature, please refer to the topic titled Zooming In and Out on the
Plot With the Mouse in the Shortcuts section.

Move Range Up / Down

View Menu > Zoom > Nove Range Up / Down

Keyboard Commands:
Move Range Up = [Page Up]
Move Range Down = [Page Down]

When you are zoomed in on the vertical (y-axis) range of the main plot, only a portion
of the wave file's full amplitude range is displayed. These two commands move the
displayed range up or down to allow you to view the information above or below the
range currently displayed.
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Amplitude

View Menu > Amplitude

l Amplitude Scale
Log (dB) S

The Amplitude Scale commands (below) are used to set the type of scaling used on
the amplitude (y)-axis of the main Intelligibility module plot. Amplitude scaling for
the impulse response plot can also be selected using the Amplitude Scale spinner
to the right of the plot in the main program window.

Linear Scale
Keyboard Command = [Ctrl] + [N]
Displays the (A/D) amplitude values on a linear scale.

Decibel Scale
Keyboard Command = [Ctrl] + [D]

Converts (linear) A/D amplitude values to decibel values.

Show

Schroeder Trace

View Menu > Show > Schroeder Trace

Schroeder
e |

Keyboard Command = [S]

In addition to plotting the raw time-domain data of the impulse response, the Intelligi-
bility module can display a second trace on the plot that is the result of a Schroeder
Reverse Time Integration calculation performed using the impulse response data. The
Schroeder trace can be useful for identifying trends in the impulse response, particu-
larly the decay slope, and can be helpful in determining reverberation time (RT60).

Schroeder Trace is a “toggle” command. Clicking the Schroeder button (shown above)
or selecting Schroeder Trace from the Show sub-menu of the View menu displays the
Schroeder trace. When the Schroeder is present, clicking the same button or select-
ing the same menu command again will remove the trace from the plot.
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Schroeder On Top

View Menu > Show > Schroeder On Top
Keyboard Command = [Ctrl] + [H]

When the Schroeder trace is displayed on the Intelligibility module plot, selecting
Schroeder On Top from the Show sub-menu of the View menu moves the Schroeder
trace to the “top” of the plot’s z-axis stacking order. The z order of the plot is of
concern in this case mainly because the precision tracking cursor always tracks

the top trace when Track Nearest Data Point is turned on.

Schroeder On Top is a “toggle” command. Selecting the same menu command again
will return the impulse response trace to the top of the z order.

ETC

View Menu > Show > ETC

ETC

P——

Keyboard Command = [Ctrl] + [E]

This command calculates and displays the Energy Time Curve (ETC) based on the
(broadband or band-limited) time-domain impulse response data. When ETC is
selected, the ETC plot replaces the normal impulse response plot in the Plot Area of
the main Intelligibility module program window. The ETC display mode can be useful
in identifying reflections and looking at the decay characteristics of a system under
test. Although the ETC plot does resemble the impulse response plot displayed on a
decibel scale, it can make discreet reflections, in particular, somewhat more promi-
nent and easier to see.

Note that a number of program features are disabled in ETC display mode. For
example, the ETC cannot be used as the basis for the intelligibility calculations and
linear amplitude scaling is not applicable to this type of display. ETC is a “toggle”
command. Clicking the same button or selecting the same menu command again
will restore the standard impulse response plot.
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Marker (Ld, Lr, Ln)

View Menu > Marker (Ld, Lr, Ln)

The Marker (Ld, Lr, Ln) sub-menu commands allow you to select and position the level
markers using keyboard or menu commands. Note that you can also select markers
by simply clicking them with your mouse and move the markers around on the plot by
clicking and dragging them (moving the mouse while holding down the left mouse
button) from one place to another. Or to “snap” the selected marker to the mouse
cursor location, hold down the [Alt] and click the left mouse button once.

Select Next Marker
Keyboard Command = [Tab]

Cycles marker selection through the Ld, Lr, and Ln markers.

Move Marker Left
Keyboard Command = [Left Arrow]

Moves the selected (Ld, Lr, or Ln) marker to the left.

Move Marker Right

Keyboard Command = [Right Arrow]

Moves the selected (Ld, Lr, or Ln) marker to the right.

Move Marker Up

Keyboard Command = [Left Arrow]

Moves the selected (Ld, Lr, or Ln) marker upward (in amplitude).
Move Marker Down

Keyboard Command = [Down Arrow]

Moves the selected (Ld, Lr, or Ln) marker downward (in amplitude).
Set Ld to Peak

Peak |

Keyboard Command = [Shift] + [P]

Resets the Level direct (Ld) marker to the highest peak in the impulse response.
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Track Nearest Data Point

View Menu > Track Nearest Data Point

The Intelligibility module features both a standard (arrow) mouse cursor and a
precision tracking cursor. The relative time and amplitude position of the precision
cursor is continuously displayed on a readout above the plot. The arrow cursor can
always be moved freely around the plot and can be used to position the Level mark-
ers. When Track Nearest Data Point is turned on, the precision cursor “snaps” to the
nearest data point on the “top” trace in the z-axis stacking order while following the
horizontal movement of your mouse. When this feature is turned off, the tracking
cursor freely follows the mouse cursor.

The z-axis stacking order is determined by the selected display options for the
Schroeder reverse time integration curve. If the Schroeder trace is not displayed, the
precision cursor tracks the impulse response trace by default. When the Schroeder
trace is present, the precision cursor will track the Schroeder trace if Schroeder On
Top is selected (see page 44).

Octave Band Filters and 1/3 Octave Band Filters

View Menu > Octave Band Filters and 1/3 Octave Band Filters

| Filter Set

|
1f3 Octave =

These two commands are used to select the filter set used for band-limited impulse
response and ETC displays. The selected filter set determines the choices available
on the Bands spinner and the Bands list box in the Intelligibility dialog box.

Channel

View Menu > Channel

=2

When a stereo wave file is loaded, only one of the two channels is displayed. You will
be asked to select which channel you want to display when the file is initially opened
but if you want to change your selection later the Left and Right commands in the
Channel submenu may be used to select either channel for display at any time.
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Options Menu Commands

All
Options Menu > All
Options |
Keyboard Command = [Alt] + [0]
This command opens the Options dialog box with the last tab used on top. Any tab
may be selected any time the Options dialog box is open.
Color

Options Menu > Color

The SIA-Smaart Intelligibility module allows you to customize the colors of virtually
everything on the screen and even use your own bitmap files as a background.
Color and background options are loaded as sets called Color Schemes. Several
ready-to-use color schemes (including two with “metallic” bitmapped backgrounds)
are included with the program and you can easily define your own. The Colors tab
of the Options dialog box allows you to create, edit and manage Color Schemes

for the Intelligibility module program window and displays.

The Colors tab of the Options dialog box is used to create and manage color schemes
for the Intelligibility Module. The Color Schemes section of the Colors tab has a list of
all available Color Schemes along with buttons for creating, editing, and deleting user-
defined schemes. A pair of list boxes below the Color Schemes section allow you to
select separate color schemes for display and printing purposes.

Color Schemes
Mew...

Clicking the New button calls the Edit Color Scheme dialog box, allowing you to create
a new color scheme. In this dialog box, you can change colors for various display
elements and optionally, a Windows bitmap (*.bmp) file to use as a background for
the program Window. Color selections initially shown in the dialog box for each
element are based on the Color Scheme currently in selected in the list. Clicking any of
the solid-colored squares opens a standard Windows Color dialog box allowing you to
choose a standard color or specify a custom color to be used for the selected element.
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Edit.. |

The Edit button calls the Edit Color Scheme dialog box to allow you to edit an existing
(user-defined) color scheme selected in the list. Note that the stock color schemes
supplied with the Intelligibility module may be used as the basis for a new user-
defined color scheme but cannot be edited or deleted themselves.

] E_Ietel

Clicking the Delete button deletes a (user-defined) Color Scheme selected in the list.
Below the Color Scheme section are two list boxes

* Display Color Scheme — Selects an existing Color Scheme to be used for display
purposes (the colors shown on your computer screen).

* Printing Color Scheme — Selects an existing Color Scheme for use when printing
from the Intelligibility module.

Devices
Options Menu > Devices

If your computer has more than one sound card installed, the Devices tab of the
Options dialog box allows you to select which of these the Intelligibility module should
use. This tab is also where you set the sampling resolution (bits per sample) for each
device. The Devices options tab has for drop-down list fields:

* Wave In — Selects the sound device to be used for audio input (recording).

* Wave Out — Selects the computer sound device to be used for output from the
internal pink noise and MLS signal generators.

* Wave In Bits Per Sample — Sets the sampling resolution for the selected audio
input (recording) device.

* Wave Out Bits Per Sample — Sets the sampling resolution for the selected audio
output device. This setting also determines the output resolution of the internal
signal generators.

At the bottom of the Devices tab is a check box labeled “Warn before recording if the
signal generator is not running.” Un-checking this check box disables the warning
message normally given if you click the Record button on either tab of the Record
Impulse dialog box when the internal signal generator is not running.
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Graph

Options Menu > Graph

Keyboard Command = [Alt] + [G]

The Graph tab of the Options dialog box has the following options for controlling the
appearance of the main plot and how the Intelligibility module displays data:

Title — At the top of the Graph options tab is a text input field used to set the title line
displayed above plot in the main program window and above the Intelligibility Graph in
the Intelligibility dialog box.

Amplitude Range — The Amplitude Range section has four text fields for setting the
upper (Max) and lower (Min) limits of both the Current and Default amplitude (y-axis)
ranges of the main plot. Note that the Current amplitude range can also be set using
the Zoom Y In/Out and Move Range Up/Down commands or by using your mouse to
zoom in and out. The Default range is the range displayed when you open a new wave
file or when you use the Zoom Out To Limits command. The options available in the
Amplitude Range section will depend on whether a Linear or Decibel Amplitude Scale
is currently selected as the range may be set independently for each scaling mode.

In Decibel scaling mode, the Min and Max amplitude range values are set in decibels
(dB). When calculating decibel amplitude values, the Intelligibility module regards
“full-scale” (the highest possible amplitude value obtainable from the wave file) as
zero dB and all other values are given as “dB down” from 0. The method used to
calculate dB values from the wave file’s linear amplitude units results in a maximum
possible decibel range of 0 to approximately —210 so the maximum displayable range
for the plot is +10 dB to —220 dB.

In Linear amplitude scaling mode, the amplitude range of the plot is set as percent-
ages of the maximum possible positive and negative amplitude values obtainable from
the wave file. The default range is normally set to +/— 100%.

Speed of Sound — The Intelligibility module uses the Speed of Sound setting to
calculate distance equivalents for time values. The speed of sound value can be
specified in either feet or meters, depending on which of the “radio buttons,” is
selected. The unit of measure selected here also determines whether distance
equivalents are displayed in feet or meters elsewhere in the program. The default
speed of sound value is 1120 feet per second or 341.359 meters per second.
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Time Range — The controls in Time Range section set the current x-axis range for
the main plot in milliseconds. The default time range is always the full length of the
wave file and the time scale is always linear. Note that the current displayed time
range for the plot can also be set using the Zoom X In/Out and Move Range Left/Right
commands or by using your mouse to zoom in and out.

Save Filter Data in Memory — \When this box is checked, filtered versions of the
wave file data are held in memory after they are calculated so that you can switch
between previously calculated passband views almost instantly. This is particularly
useful when you are looking at the lowest (octave or 1/3-octave) passbhands where
the calculation time for filtering can be significant even on a very fast machine. You
will probably want to leave this box checked unless your computer has very limited
system resources available and you need to minimize the amount of memory the
Intelligibility module requires.

Clarity — This value, specified in milliseconds, determines the Clarity Factor dis-
played in the Intelligibility Graph and in the All Bands Table. For example, if this value
is set to 50 milliseconds (the default setting), the Intelligibility module will use C50 as
the Clarity Factor in intelligibility displays. Changing this number to 7 or 35 will change
the Clarity Factor to C7 or C35 respectively.

Meter

Options Menu > Meter

The settings on the Meters tab of the Options dialog box control the appearance and
behavior of the Input Level Meters in the Record Impulse dialog box. The meters are
calibrated to regard the maximum digital output of the A/D system of the sound card
being used (normally 16-24 bits) as 0 dB with all other values given as “dB down”
from zero.

The following meter options are user-definable:

* LED Levels — The Intelligibility module allows you to specify amplitude values
for each individual (Left/Right) pair of “LEDs.”
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* Peak Hold — \When this box is checked, the meters will continue to indicate the
highest amplitude level encountered in the input signal for a specified period of
time after the level drops off.

* Hold Peak For — Specifies the length of time (in seconds) the meters will hold
peak levels when Peak Hold (see above) is enabled.

* Averages — Setting this value to a number higher than one will cause the meters
to display a running average of the specified number of samples rather than simply
reacting as fast as it can to changes in the input signals. This will tend to stabilize
the meter reading, which may be desirable given the random, or pseudo-random
stimulus signals typically used in recording impulse response measurements. Note
that this increased stability comes at the cost of degrading the meter ballistics.

Meter LED Colors

The Input Level Meters are designed to display three colors, the normal “LED” color
(Light Green for the Left input and Light Blue for Right) plus Yellow and Red. The meter
“LEDs" will display input levels in the normal LED color up to the amplitude threshold
specified for Yellow, then Yellow up to the threshold for Red, and Red above that level.

* Yellow if above — Sets the threshold amplitude at which the LEDs change
to Yellow.

* Red if above — Sets the threshold amplitude above which the LED color
changes to Red.

Numeric Readout — The numeric value that appears above the Input Meters

in the Record Impulse response can be set to track either the current signal level
(Show Current Value) or the peak value (Show Peak) by selecting the appropriate
“radio button” in this section. Note that the Show Peak option for the numeric
readout may be used with or without the Hold Peak option (see above) enabled
for the meters themselves.

SIA-Smaart Acoustic Tools Version 4 User Guide Page 51



Chapter 2: Intelligihility Module Functions and Commands

Printing

Options Menu > Printing

The Printing tab of the Options dialog box controls the appearance and content
of pages printed directly from the Intelligibility module. The following options are
user-definable:

Title (1, 2, and 3) — You can specify up to three lines of title text to appear at the
top Intelligibility module printouts. If any of the three Title fields is left blank, that
line is omitted on the printed page.

Print Type — The two radio buttons in this section determine what type of
information will be printed. When the Impulse and Intelligibility Graphs option
is selected, the printed page will include both the impulse response plot and the
Intelligibility Graph. If the All Bands Table option is selected, only the All Bands
Table is included on the printout.

Print File Name — When this box is checked, the name of the wave file currently
loaded in the Intelligibility module (on which the printed information is based) will
be included in the title area at the top of the printed page.

Print Today’s Date — If this box is checked, the current date (as set on your
computer) will be inserted in the title area at the top of the printout. If you want
to use a date other the current system date of your computer on the printout,
un-check this box and type the desired date as one of the Title lines.

Show custom print dialog before print and print preview — When this box

is checked, selecting either the Print or Print Preview commands will open the
Custom Print Information dialog box to allow you to set title text and other options
for the printout before proceeding with the selected operation. The Custom Print
Information dialog box includes all of the same options as the Printing tab of the
Options dialog box. If you un-check this check box, the Intelligibility will bypass
the Custom Print Information dialog box in Print and Print Preview operations and
execute the selected command immediately.
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Intelligibility Module Keyboard Shortcuts

The following is a list of the Intelligibility keyboard commands (hot keys). Note that
all of these commands are also available as menu commands and in some cases, as

on-screen buttons or controls.

Key names on the list below are enclosed in [brackets] to differentiate them from
descriptive text. Some commands use more than one keystroke, for example the
accelerator key sequence to show/hide the Schroeder Trace is “[Ctrl] + [S].” This
means you must hold down the Control key while you press the S key.

Display

Decibel Scale = [Ctrl] + [D]

Linear Scale = [Ctrl]] + [N]

Schroeder Trace = [S]

Schroeder Trace On Top = [Ctrl] + [H]
ETC = [Ctrl] + [E]

Intelligibility Graph = [Ctrl] + [I]

All Bands Table = [Ctrl] + [B]

File

Open File = [Ctrl] + [0]

Save As = [Ctrl] + [S]

Record Impulse = [Ctrl] + [R]

Create Impulse From File = [Ctrl] + [F]
Print = [Ctrl] + [P]

Marker (Ld, Lr, Ln)

Move Selected Level (Ld, Lr, Ln) Marker
= [Arrow] Keys (Up, Down, Left, Right)

Select Next Level Marker = [Tab]
Set Ld Marker To Peak = [Shift] + [P]

Options

All Options = [Alt] + [0]

Graph Options = [Alt] + [G]

Zoom and Range

Undo Zoom = [Ctrl] + [Z]

Redo Zoom = [Ctrl] + [A]

Zoom Out To Limits = [Home]

Zoom X In = [Ctrl]] + [Down Arrow]
Zoom X Out = [Ctrl] + [Up Arrow]
Move Range Left = [Ctrl] + [Left Arrow]

Move Range Right = [Ctrl] + [Right
Arrow]

ZoomYIn = [+]

Zoom Y Out = []

Move Range Up = [Page Up]
Move Range Right = [Page Up]
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Chapter 3: Analysis Module Functions
and Commands

Navigating in the Analysis Module
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Like the Intelligibility module, the Acoustic Tools Analysis has a completely rede-
signed user interface that speeds access to the most frequently used program
functions. Again, simply the clicking the label or readout field for an on-screen control
or readout will allow you to access nearly any associated parameter or option you are
likely to need for all but the most advanced features. Readouts have been enlarged
and where appropriate, the text is color coded to match the associated trace color.
This helps make it easier to understand at a glace exactly what you are seeing.

The following is a brief description of the basic elements that make up the Analysis
module program window. Detailed information on Analysis module displays and
functions can be found in Analysis Module Functions, beginning on page 59.
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The Menu Bar

File  Audio “iew Optons: Help

Virtually all of the program functions that are available as on-screen controls and/or
keyboard commands are also accessible through the pull-down menus on the Menu
Bar. Menu commands also provide access to many less commonly used features.

To activate a pull-down menu from the Menu Bar, click on its name using your mouse
or hold down the [Alt] key while pressing the key corresponding to the underscored
letter in the menu name. When a menu is open, commands may be selected by
clicking on their names with your mouse or by typing the underscored letter.

Menu commands followed by ellipses (three periods...) call dialog boxes. An arrow-
head at the right of a menu item indicates that this command activates a nested
“fly-out” submenu. For explanations of Analysis module menu commands, please
refer to Analysis Module Commands beginning on page 68.

File 1 Information

File1 | Room.way 44562 samples Hg

This section of the Analysis module window provides information about the primary
wave file loaded in the Analysis module. The (Open) File 1 button calls an Open file
dialog box allowing you to select a wave file to load. The next field to the right
displays the file name of the wave file after opening it.

Immediately to the right of the file name field are two fields that display the number
of samples in the file and the sampling rate and resolution (bits/sample) at which the
data was recorded. Clicking on either of these two fields with your mouse will open
the File Information dialog box (see page 69) with additional details about the file(s)
currently loaded. When a stereo wave file is loaded, the (L and R) channel buttons
select which channel is displayed.

FFT Information

IFFT 1024 (75%), FR 43.1 Hz

The FFT information field immediately to the right of the File 7 information fields
provides details about the frequency domain data calculated for the current wave
file(s) by the Analysis module's Transform function (see page 71). The values
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displayed here include the FFT size (in samples) the overlap percentage, and the
frequency resolution of the FFT. Clicking anywhere in this field calls the Transform
dialog box to allow you to transform or re-transform the wave file data for the
Analysis module’s frequency-based displays.

File 2 Information

Filezl Room2.way 44486 samples Ml Llil

This section provides information about a second wave file loaded in the Analysis
module. The (Open) File 2 button calls an Open file dialog box allowing you to select a
wave file to load. The next field to the right displays the file name of the wave file after
opening it. Clicking this field with your mouse pops up a menu that will allow you to
close the second wave file or select another file to open as File 2.

Immediately to the right of the File 2 file name field is a field that displays the number
of samples in the file (the sampling rate and bits/sample for File 2 must be identical to
File 1). Clicking on this field with your mouse will open the File Information dialog box
(see page 69) with additional details about both files currently loaded. The Top Trace
button cycles the z-axis stacking order in multiple trace displays. If File 2 is a stereo
wave file, the (L and R) Channel buttons select which channel is displayed.

Audio Controls

Rec I Play I PauseI Stop I

The Audio controls provide access to the Analysis module’s Record function and the
means to start, pause and stop audio playback of an open wave file. When two files
are loaded the file currently displayed it front will be played. For more information,
see Audio Menu Commands, beginning on page 75.

Tracking Cursor Readout

0.4393 sec, -60.48 dB

This field gives you x and y axis (along with z in Spectrograph mode) coordinates for
the Analysis module's precision tracking cursor when the mouse cursor is positioned
over the main plot area or the Waveform display. Coordinates are given in seconds,
dB, amplitude percentage or Hertz, as appropriate for the display type.
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Relative Cursor Readout

(0.5753 sec, 644' 4", -28.78 dB)

In Time Display and Time Slice modes, you can use your mouse cursor find the time
and amplitude/magnitude difference between two points in the main display by
holding down the left mouse button and drawing a line on the plot. The line you draw
remains visible on the plot when you release the mouse button, and the difference
between the line's end points are displayed in this field. In Time Slice mode (only),
the decay slope in decibels per second and equivalent RT60 value are also calculated
and displayed here. See Delta/Decay Rate Calculation on page 102 for more details.

The Waveform Display

38'G]I!—
... I

' [ ] 1
0.000 0.250 0500 0.750 1.000

The Waveform Display, located above the Plot Area, is a simple time-domain repre-
sentation of the waveform (*.wav) file(s) open in the Analysis module. This display
serves as a visual locator for the data being displayed main Plot Area. In Time Display,
Time Slice, and Spectrograph modes, locator bars in the Waveform Display indicate
the boundaries of the currently-displayed time range. In Frequency Slice mode, the
Waveform Display indicates the location of the currently-displayed FFT frame.

The amplitude (y-axis) scale of the Waveform display is specified as a percentage

of the full (digital) amplitude scale of the wave file. For example, when a 16-bit file is
loaded, 100% represents a range of +/— 32767 A/D units. The amplitude scale of the
waveform display is set from the Waveform tab of the Options dialog box (see page 99).

The Plot Area

The Plot Area is the Analysis module’s main display area for data plots in all display
modes. Both the Waveform display (see above) and the Plot Area will appear blank
until a wave (*.wav) file is loaded. When a new file is loaded, a time-domain (time vs.
energy) representation of the wave file data appears in the Waveform Display and a
more detailed version (the Time Display) is shown in the Plot Area.

The Analysis module requires the waveform file’s time-domain data to be transformed
into the frequency domain using the Transform feature (see page 71) before any of the
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other display modes are enabled. Once the wave file has been transformed and the
companion frequency-domain (*.sia) file created, you can select any of the four
primary display modes.For more information about Analysis module display modes,
please refer to Analysis Module Functions beginning on page 59.

Jump to Other Programs

Intelligibility

Clicking the Intelligibility button in any display mode will automatically close the
Analysis module while opening the Intelligibility module and loading the file that was
open as File 1 (in the Analysis module).

RcousticTools

Clicking the Acoustic Tools logo above the Intelligibility button will pop up a menu that
allows you to jump to, and pass data to other programs if there are jumps defined it
wrjumps.txt. See Setting Up Links to Other Programs on page 26 or more information
about this feature.

Display Modes

Time Disp | Time Slice
FE————

Spectro | Freq Slice
LI\ |

The Display Mode buttons switch the Analysis module between its four primary
display modes. For information about Analysis module display modes, see Analysis
Module Functions beginning on page 59.

Mode-Specific Controls

The controls in the area will below the Display Mode buttons (see above) will vary
based on the primary display mode currently selected. The Transform and Options
buttons are always visible along with the Rainbow and Power Spectrum buttons in
Time Slice and Frequency Slice modes respectively. Below these buttons you will see
range and scale and/or banding controls appropriate for the primary display currently
selected. See Analysis Module Functions, beginning on page 59, for more information
about Analysis module display modes.
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Analysis Module Functions

The Time Display
Time Dlsp e Augm View Gptions_Help
! L[] [ ReousticToolo
i i . . File2 TopTrace | LR Rec | pray Inteligibilty
The Time Display is a detailed ot s
view of the wave file’s time |
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The default time (x-axis) scale
shows the entire waveform. You can zoom to a specific portion of the waveform
using the arrow keys, the Time Zoom commands in the View menu, or by clicking
and dragging (horizontally) the with the mouse in the Waveform Display. The Locator
Bars in the Waveform Display indicate the limits of the time range currently being
displayed on the main plot.

Amplitude Scale
Log (dB) S

The vertical (y-axis) range of the plot can be changed using the Amplitude > Zoom
and Move commands in the View menu or specified on the Time Display tab of the
Options dialog box. The amplitude scaling options for the Time Display plot are:

Log (dB) — Logarithmic amplitude scaling takes the linear A/D amplitude data and
calculates a decibel value (relative to 32767) for each amplitude unit (except 0).

Lin (%) — Linear amplitude scaling represents amplitude linearly as a percentage of
the full scale of the wave file (based on bits per sample used to record the data).

Absolute (%) — Absolute Value Scaling uses a linear amplitude scale, however the
absolute value of each data point is plotted (all negative values are converted to
positive). As with Linear scaling, amplitude values are given as a percentage of the
full scale of the wave file.
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(0.5753 sec, 644" 4", -28.78 dB)

In Time Display mode you can use your mouse to find time and amplitude difference
between any two points on the plot. Just drag the mouse (hold down the left mouse
button while moving) across the plot to draw a line between the two points. When
you release the mouse button, the difference between the end points of the line is
displayed on the slope readout (shown above) located directly above and to the right
of the Waveform Display. To remove the line, click once on the plot. The units used in
the Time Display cursor and slope readouts are user-selectable. You can choose to
display any combination of time (in seconds), samples, feet, or meters by selecting
the appropriate options on the Time Display tab of the options dialog box.

All distance values in the Analysis module are calculated from the Speed Of Sound
value, also set from Time Display options. The default Speed Of Sound value is 1120
feet (341.35 meters) per second.

The Time Slice
Time Slice
,_l
Pl Room2.way | ssies samvies | a0 - JYMEYIERY 115 . e 0 v

B | e e——"
0.4598 sec, -22.10 dB [l (0.6650 sec, -23.76 dB), Slope=-35.51 dB/sec, TE0=1.7 se¢

The Time Slice display is
similar to the Time Display in
that it plots time on the x-axis
vs. magnitude on the y-axis
however there are a couple of
important differences. First,
the time slice shows you data
for only a narrow frequency
range. Bandwidth options
available for this display mode
are Narrowband, Octave or 1/3-Octave. The other big difference may be less obvious
but in Time Slice mode, you are actually looking at FFT data instead of the raw, time-
domain audio data shown in the Time Display. This is why the Time Slice trace
appears much smoother than the band-limited time domain displays in the Intelligibil-
ity module. Time domain displays plot one data point for each sample in the wave file
whereas on the Time Slice plot, there is one data point for each FFT frame.

500.0 Hz i
[ g

Magnitude (d8)

]3] o]
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The time resolution of the Time Slice plot as well as the bandwidth of the Narrowband
Time Slice display is determined by the frequency resolution of the FFT size selected
when the wave file is transformed.

| Band
| _5000H: [
id
The current center frequency and bandwidth are shown on the Band and Banding
spinners that appear to the Right of the plot in Time Slice mode. The center frequency

the Time Slice plot is selected using the Band spinner or the Next Slice and Previous
Slice commands under Slice in the View menu.

Rainbow

F——

The Rainbow display simultaneously plots the normal Time Slice and two sidebands.

By default, the sidebands are 1 or 1/3 octave up and down from the center frequency
depending on the selected bandwidth (the Narrow Band option is not available in the

Rainbow display). Specific sideband frequencies can be specified on the Rainbow tab
of the Options dialog box. The three traces can be Normalized, or aligned in amplitude
at a specific time location holding down the [Shift] key while clicking on the plot with

the left mouse button. Pressing the [N] key toggles normalization on and off.

The Time Slice can be very useful for determining decay rates in a room impulse
response. Because it tends to be much smoother than simple time domain displays,
overall trends in the impulse response are easy to see. You can draw a line on the
Time Slice plot by holding down your left mouse button while moving the mouse
cursor between the two points on the plot. When you release the mouse button, the
decay rate in dB/sec. and equivalent RT60 values are displayed in the relative cursor
readout immediately above the plot to the right of the standard cursor readout.
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The Frequency Slice
Freq Slice e

B Foomz vy [ e R R T L BT

Time Disp | Time Slice
Spectio | FreqSiice

The Frequency Slice shows
magnitude (y-axis) versus
frequency (x-axis) for a given
frame — in effect, a still-frame
spectrum analyzer. The FFT
data may be displayed in
Linear, Logarithmic, Octave,

or 1/3-Octave frequency
scaling. The highest magni-
tude value found in all the

FFT frames calculated for the wave file is regarded as 0 dB. All other magnitude
values on the Frequency Slice plot are given relative to this 0 dB point.

Frame
1(0.01 5ec) St

| Frouency Scale
Log (NE) [

Magpitudle (B)

|
]2 ] o

In Frequency Slice mode you can “step through” each of the FFT frames calculated
for the file using the Next Slice and Previous Slice commands under Slice in the View
menu ([SpaceBar] or [Shift] + [SpaceBar] on your keyboard) or using the Frame
spinner that appears to the right of the plot in Frequency Slice mode. Also, because
each FFT frame represents a different time location, the (Time Zoom) pan controls
(the Left and Right arrow keys) can be used in this mode to step through “slices.”

| Frame

1(0.02 sec) S

Frame locator bars in the provide a visual reference for the time position of the data
from which the currently displayed FFT was calculated. Selecting Go To Slice, under
Slice in the View menu or clicking the Frame spinner displays the Go To dialog box,
allowing you to specify the frame you want to display by time location or FFT frame
number. You can also select a time location in Frequency Slice mode by clicking on
the trace in the Waveform Display with your left mouse button.
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| Frequency Scale

Log (NB) S

The frequency (x-axis) scaling of the Frequency Slice plot is set by the Frequency
Scale spinner that appears ti the right of the plot in Frequency Slice mode. The range
and scale of the plot’s vertical (y) axis may be changed using the Amplitude > Zoom
and Move commands in the View menu. The amplitude range for this display can
also be set from the Frequency Slice section of the Slice tab in the Options dialog
box. The label above the plot shows the current resolution (narrowband, 1-octave,
or 1/3-octave) the frame number, and the start time of the frame currently displayed.

Power Sp. |
L] {th

The Power Spectrum is a special type of Frequency Slice display. The Power Spec-
trum is a plot of the average of all, or a selected range of FFT frames calculated for a
wave file. The power spectrum display is activated by pressing the Power Spectrum
button that appears to the right of the plot in Frequency Slice mode.

l Frame Range

0-170

When Power Spectrum is on, you can also set the time range over which power
spectrum is calculated by clicking the Frame Range readout to the right of the plot
and entering a range of FFT frames in the pop-up dialog. The time range over which
the Power Spectrum is calculated can also be specified using time coordinates or
FFT frame numbers on the Power Spectrum tab of the Options dialog box.
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The Spectrograph
Spectro | o vien _Dpers_ 1

! RBI _Room.way ez enes oo o SRR oo ov- i IR
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The Spectrograph is a “topo- R = ==
graphic” representation of e
3-dimensional data, with time i fon]
along the x-axis, frequency e

along the y-axis, and ampli- B
tude rgprese.ntefi by cglor. £ =
This display is similar in I <
m
concept to the so-called 1]2]3]oeram |

“waterfall” display, however
we feel the Spectrograph display is much easier to read and interpret than a
waterfall plot once you become accustomed to it.

By default, the all frequency-based displays in the Analysis module regard the highest
magnitude value actually encountered in the wave file as 0 dB. The magnitude value
for every other frequency data point is calculated relative to this 0 dB point. Selecting
Full-Scale on the Calibration tab of the Options dialog box re-scales the Spectrograph
to regard the maximum magnitude obtainable (given the wave file's sampling resolu-
tion) as 0 dB. The Full-Scale and Custom calibration options are particularly useful
when comparing multiple wave files.

A legend area below the plot shows the number of colors used and the Dynamic
Range of the Spectrograph. The value of dB/color is displayed to the right of the color
scale bar. The magnitude range represented by each color used is determined by the
number of colors used and the specified dynamic range. These parameters are set
from the Spectrograph tab of the Options dialog box. The Spectrograph may be
displayed in up to 236 colors.

| Banding

Log (NB) S

The frequency range of the Spectrograph plot’s y-axis is set using the four user-
configurable Frequency Zooms. The frequency (y-axis) scale can be linear or

Page 64 SIA-Smaart Acoustic Tools Version 4 User Guide



Chapter 3: Analysis Module Functions and Commands

logarithmic. Frequency scaling may be selected using the Banding Spinner that
appears to the right of the plot in Spectrograph mode or on the Spectrograph tab of
the Options dialog box.

| Frame Range

0-170

The Spectrograph plot is actually made up of vertical bars, with each bar representing
one FFT frame. The vertical bars are divided into sections representing individual FFT
data points with the magnitude for each point indicated by color. By default, all FFTs
calculated for a wave file are displayed to show the entire time range of the file along
the x axis. You can select a specific time range using the Time Zoom commands, by
selecting a time range in the Waveform display, or by clicking the Frame Range
readout and entering a range of FFT frames in the pop-up dialog box.

Two options are available on the Spectrograph tab of the Options dialog box that alter
the way the individual sections of the vertical bars are plotted. The option used in the
illustration above is the default Uniform setting. This option displays the Spectrograph
as a continuous color map. Selecting Relative varies the (horizontal) width for each
section relative to its magnitude value (higher magnitudes are wider).

Comparing Two Wave Files

The Analysis module allows you to open two files at the same time and compare their
time- and frequency-domain data in Time Display, Time Slice, and Frequency Slice
display modes. This feature is useful for assessing the effectiveness of acoustical
treatment in a room or any other application that requires comparing two signals. The
Analysis module can also create a new wave file that represents the difference
between the two files.

File1 | Room.wav 44562 samples Hg

To load a second file into the Analysis module, first open File 1 as you normally would
the click the File 2 button above and to the left of the plot. This button calls a Win-
dows Open file dialog box prompting you to select a wave file. The second wave file
must be recorded at the same sampling rate and resolution (8-24 bits/sample) as

File 1 and must be of the same type (stereo or mono) but does not have to be exactly
the same size.
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Filezl Room2.wav [ 44486 samples Ml Ll El

After you have made your selection, the Analysis module will automatically switch to
Time Display mode and plot a signal trace for each of the two files in different colors
(light green for File 1 and light blue for File 2 if the default Color Scheme is used).
When a second file is loaded, it is displayed "on top" of File 1 in the z-axis stacking
order by default. In other words, the File 2 trace will cover the File 1 trace, both in the
Waveform display and on the Time Display plot in the main plot area, anywhere the
two traces overlap. To bring the File 1 trace to the top, click the Top Trace button.
Clicking this button again brings File 2 back to the top and so on.

=2

When stereo wave files are loaded, the Analysis module displays only one channel
for each file. The Channel (L/R) selector buttons to the right of the File 7 and File 2
information fields at the top left of the Analysis module window are used to select
which Channel is displayed. There are separate channel selector buttons for each file
so you can select either channel of either file for display independently. Note that by
loading the same stereo wave file as both File 1 and File 2, you can use this feature to
view both channels of the file simultaneously.

Important Note: The file displayed on top is always the object of all commands that
act only on one file at a time such as the Save Wave Zoom As, and ASCII Save
commands. Also, the tracking cursor always tracks along the top trace when Track
Data is enabled.

Adjusting the File 2 Time Offset

When two files are loaded, the maximum displayable time range will be equal to the
length of File 1. If File 2 is longer, its time range is truncated. To adjust the time
position of File 2, for example to align peaks in the two traces, use the keyboard
commands below. These commands are available only in Time Display mode.

Fine Adjustment

* Hold down the [Ctrl] key while pressing the [Left Arrow] to move the File 2 trace
one pixel to the left.

 [Ctrl] + [Right Arrow] moves the File 2 trace one pixel to the right.
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Coarse Adjustment
 [Ctrl] + [Shift] + [Left Arrow] moves File 2 left in larger increments.
 [Ctrl] + [Shift] + [Right Arrow] moves File 2 right in larger increments.

Clear File 2 Time Offset
e [Ctrl] + [R] removes all time offset.

Note: You can also specify the File 2 offset in samples in the File Information dialog
box. To open the File Information dialog, select File Info from the File menu or click
either of the two fields immediately to the right of the file name readout for File 7
where the number of samples, sampling rate and resolution for the file are displayed.

Transforming File 2

AN 1024 (75%), FR 43.1 Hz

Before the Analysis module can display frequency information for the two wave files,
both must be transformed using identical transform parameters. When two files are
loaded, transforming File 7 will automatically transform File 2 using the same param-
eters and the frequency-domain information for File 2 is stored in a temporary file. If
File 1 has already been transformed, selecting Time Slice or Frequency Slice mode
automatically transforms File 2 (only) using the same parameters as were previously
used file for File 1. Note that the Spectrograph display mode, and the Rainbow display
in Time Slice mode are not available when two files are loaded.
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Analysis Module Commands

File Menu Commands

Open File 1
File Menu > Open File 1
Keyboard Command = [Ctrl] + [O]

File1 | Room.way 44562 samples Hg

This command calls the Open file dialog box allowing you to select a standard
Windows audio waveform (*.wav) file — also called a “wave” file — to be opened
for analysis. This dialog box is modified to show the sampling rate, resolution (8-

to 24-hit), type (stereo or monaural), and the length, in samples and seconds, of the
file you select. When a wave file is opened, the Waveform Display and Time Display
plots appear. If a stereo file is loaded, only one channel is displayed. You can switch
between channels using the L and R (left/right) channel selector buttons.

Close File 1

File Menu > Close File 1

Closes the wave file. If two files are loaded, this command closes both.

Open File 2

File Menu > Open File 2
Keyboard Command = [Ctrl] + [Shift] + [O]

Gl Room2.way [aaass samples RGN

This command calls an Open file dialog box allowing you to select a second wave file
to be loaded for comparison with the first. File 2 must be of the same type (monaural
or stereo) sampling rate and resolution (bits per sample) as File 1. The data from the

second file is plotted in a different trace color.

By default, the second file is displayed "on top" of File 1 in the z-axis stacking order. In
other words, the File 2 trace will cover the File 1 trace, both in the Waveform Display
and on the main Time Display plot, anywhere the two traces overlap. To bring the File 1
trace back to the top, click the Top Trace button. Clicking this button again brings File 2
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back to the top and so on. The file displayed on top is the object of all commands that
act only on one file at a time such as the Channel selection (for stereo files), Save
Wave Zoom As, and ASCII Save commands. Also, the precision cursor always tracks
along the top trace when Track Data is enabled.

Note: By loading the same stereo wave file as both File 1 and File 2, you can use this
feature to view both channels of the file simultaneously.

Close File 2
File Menu > Close File 2
Keyboard Command = [Ctrl]] + [Shift] + [L]

Closes File 2. File 1 remains open.

File Info

File Menu > File Info

Opens the File Information dialog box. This dialog box gives you the following informa-
tion about the file(s) currently open in the Analysis Module:

» Sampling rate

* Sampling Resolution (8- to 24-bit)

* File type (stereo or mono)

* The name of each file

* The length of each file in samples and seconds

* The text comment in the *.sia file (created when the wave file is transformed),
if applicable

When two files are loaded the Shift field displays the time offset, in samples, for File
2. You can adjust the offset by typing in a new value in this field. The time offset for
File 2 can also be changed using menu, keyboard, or mouse commands. Please refer
to File 2 (View menu commands) on page 84 for more information.
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Intelligibility

File Menu > Intelligibility

Intelligibility

This command opens the SIA-Smaart Intelligibility module, automatically loading the
same wave file currently that is open in the Analysis Module. Since neither program
normally alters the wave file in any way, it is not a problem for the two programs to
have the same file open at the same time. For more information about the Intelligibility
module, please refer to Chapter 2 of this manual, beginning on page 6.

Save Wave Zoom As

File Menu > Save Wave Zoom As

This command allows you to save just the displayed portion of the time range of a
wave file loaded in the Analysis module as a new wave file. After selecting a portion
of an open file you wish to save using the Time Zoom commands (see page 78), select
this command to call the Save As file dialog box. In the dialog box, select (or create)
the destination folder then enter a file name and click the Save button. The new wave
file is immediately loaded into the Analysis module after saving. The original wave file
is not altered in any way.

Note: If two files are loaded, this command applies only to the one displayed in front.

Save Difference As

File Menu > Save Difference As

With two files loaded, this feature allows you to create a new wave file that repre-
sents the difference between the two. Save Difference As subtracts the amplitude
value of the file displayed in front, sample by sample, from the one in back. The
Change "Z" Order command can be used to control which file gets subtracted from
which. After completing its calculations, the Analysis module opens a you will be
prompted to select a destination folder and enter a file name for the new wave file.
The new file is immediately loaded into the Analysis module after saving. The original
files are not altered.
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ASCII Save

File Menu > Save Difference As

In Time Display and Frequency Slice modes, the ASCI/ Save command creates a
standard ASCII text file from the data displayed on the plot. ASCIl output files have a
header with the creation date and information about the wave file followed by time-
or frequency-domain data (depending on the display mode in use) in numeric form:

 ASClIIfiles created in Time Display mode have a single column of amplitude values
for each displayed time-domain sample.

* ASCllIfiles created in Frequency Slice display mode are formatted as a five-column
table with information about each data point in the FFT frame currently displayed.

After converting the data to ASCIl format, the Analysis Module opens a Save As file
dialog box. In the dialog box, select a destination folder and enter a name for the text
file. You can also enter comment text to be included in the file header if you like.

Notes:
When two files are loaded, only the one currently displayed in front is exported.

In Time Display mode, the Time Zoom feature can be used to select just a portion
of the wave file for export. If you are “zoomed in” on the time axis, only the samples
within the displayed time range are exported.

Transform

File Menu > Transform

Transform |

Keyboard Command = [Ctrl] + [T]

The Analysis module requires the time-domain data contained in waveform files to be
transformed into the frequency domain before many of it's features can be accessed.
The Analysis module calculates frequency-domain data for the waveform file using a
series of Fast Fourier Transform (FFT) calculations. The Transform command calls the
Transform Waveform File dialog box, prompting you to select FFT Size, Overlap, and
Data Window parameters and enter a text Comment if you wish.
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Selecting Transform Parameters

Selecting an appropriate FFT size, Overlap and Data Window can sometimes require
some trial and error. The FFT size is the number of time-domain samples to include in
each FFT. The combination of the FFT size selected and the wave file's sampling rate
determine the frequency resolution of the FFTs (the number of Hertz between each
FFT data point).

The frequency resolution for the currently-selected FFT size is shown to the right of
the Size selector in the FFT Parameters section of the dialog box (FR = n Hz). Larger
FFT sizes yield better frequency resolution, but can sometimes hide important
changes in the data, due to the longer amount of time encompassed by the FFT.

Overlapping acts to smooth the data, often providing the Spectrograph with clearer
information. Note that overlapping data increases the number of FFT calculations and
therefore, the time required to create and display the frequency domain data. Overlap
is specified as the percentage of data each FFT shares with the previous one.

Data Windows are used to reduce “edge effects” associated with the finite length
of FFTs. The Analysis Module provides several different Data Window options. If you
don’t have another preference, the (default) Hanning or Hamming window types
generally work well. The option labeled “None” (also called a “rectangular” data
window) is typically not used.

IFFT 1024 (75%), FR43.1 Hz

After transformation, the FFT size and Overlap, and FFT frequency resolution (in Hertz)
are displayed in the FFT information field at the top of the Analysis module window to
right of the fields that display the number of samples, resolution and sampling rate for
File 1. The frequency-domain data derived from the wave file data is stored in a
separate file having the same name as the source wave file except that the file name
extension “.sia” is used. This process is nondestructive to the wave file data and may
be repeated as many times as you like. The original wave file is not altered in any way.

The *.sia file is created in the same folder (directory) as the source wave file. As
long as these two files are kept together in the same folder, the Analysis module will
automatically find and load the existing *.sia file when the *.wauv file is loaded again.
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Configuration

File Menu > Configuration

The Configuration commands are used to import and export configuration files.
Configuration data for the Analysis module is stored in the Windows registry.
The program'’s registry stores the state of nearly all user-definable parameters.

Export

This command is used to extract a copy of the entire Analysis module registry from
the Windows registry (registration database) to a (*.reg) file on disk. Selecting Export
opens a standard Windows file Open dialog box allowing you to specify a file name
and destination folder for the new file. This feature is useful for backup purposes or
moving your preferences to a new computer.

Import

The Import command opens a standard Windows Open file dialog box, allowing
you to import a previously-saved registry (*.reg) file into the Windows registry.
This replaces all registry entries for the Analysis module with the information in
the registry file.

Print

File Menu > Print
Keyboard Command = [Ctrl] +[P]

The Print command first takes you to the Custom Print Information dialog box to allow
you to set title text and other options for the printout before printing. The Custom Print
Information dialog box can be used to set all the same printing options as the Printing
tab of the Options dialog box. After setting title and page options, click the OK button
in the Custom Print Information dialog. A standard Windows Print dialog box will then
open to allow you to select a printer and set up your printer options before sending the
document to print.

Note: If you un-check the “Show custom print dialog before print and print preview "
check box on the Printing tab of the Options dialog box or the check box labeled
“Show this dialog before print and print preview " in the Custom Print Information
dialog box, both the Print and Print Preview commands (see next page) will bypass
the Custom Print Information dialog box and take you directly to the Print dialog box.
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Print Preview

File Menu > Print Preview

The Print Preview command first takes you to the Custom Print Information dialog

box to allow you to set title text and other options for the printout before proceeding.
When you click the OK button in the Custom Print Information dialog box, the Analysis
goes to Print Preview mode to show you “what-you-see-is-what-you-get” (WYSIWYG)
preview of how the printed page should look. You can then use the Print button to
send the document to the currently selected printer immediately and exit Print
Preview mode or select Close to return to the normal Intelligibility module program
window without printing the document.

Print Setup

Exit

File Menu > Print Setup

The Print Setup command opens a standard Windows Print Setup dialog box where
you can select a printer and set up the page size, orientation, and paper source for
hard copy output. Depending on the type of printer selected, there may be additional
options you can access by clicking the Properties button in the Print Setup dialog.

File Menu > Exit

Keyboard Command = [Alt] + [F4]

Ends your SIA-Smaart Analysis module session and returns you to the Windows
desktop.
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Audio Menu Commands

Rec I Play I Pausel Stop I

Record

Audio Menu > Record

The Record command opens the Record Wave File dialog box. This dialog box is a
simple wave file recording control panel. To record a new wave file on your
computer’s hard disk:

* Enter a name for the new file in the Output File field. The Browse button calls a
standard Windows Open file dialog box, allowing you to select the destination
folder (directory) for the file.

* Enable the Stereo “check box" if you want to record a stereo wave file.

* Check the level of the signal(s) coming into the sound card inputs on the input level
meters — the right channel meter is only active if the Stereo check box is enabled.
If the clip indicators light, this indicates that the input signal is overloading the
sound card inputs and should be adjusted before recording.

* Select the sampling rate. This determines frequency content of the wave file.
44.1 k or 48 k is required for full-bandwidth audio. 22050 is sufficient for speech.

* Select the “Bits per sample” (the digital resolution). 16-bit resolution is recom-
mended for most applications.

* Click the Record button. The counter begins running and the Record button
changes to a Done button.

The length of the recording is limited only by the amount of disk space available.
When you are finished recording, click the Done button to close the dialog box and
immediately load the new wave file into the Analysis module. To exit the dialog box
without loading the recorded file, click Cancel.
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Play

Audio Menu > Play
Keyboard Command = [Shift] + [P]

The Play command begins audio playback of a wave file open in the Analysis module.
If two files are loaded, the one displayed on top is played. If you are “zoomed in” on
the time axis, only the displayed portion of the file is played. During play, a progress
indicator shows the approximate time position of the data being played.

Pause

Audio Menu > Pause
Select this command to pause the audio playback. Repeat the command (toggle off)
to resume the playback at the point at which it was paused.
Stop
Audio Menu > Stop
Stops audio playback.
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View Menu Commands
Mode

The Mode commands switch the Analysis module between its four primary
display modes:

Time Display

View Menu > Time Display

Time Disp |
e

Keyboard Command = [D]

The Time Display plots a detailed view of the time-domain (time vs. amplitude) data in
a wave file. The Time Display is the only display mode that can be accessed before
transforming a wave file. For more information, please refer to The Time Display on
page 59.

Time Slice

View Menu > Time Slice

Time Slicel
Keyboard Command = [T]

Time Slice mode plots magnitude vs. time for a given frequency range (Narrow Band,
Octave, or 1/3-Octave). You could think of this plot as a horizontal slice of the Spec-
trograph. The Time Slice display is particularly useful for looking at impulse response
data. For more information, please refer to The Time Slice on page 60.

Frequency Slice

View Menu > Frequency Slice

Freq Slice |
RS EIES

Keyboard Command = [F]

The Frequency Slice displays a magnitude vs. frequency plot of a selected FFT frame
(“slice”) — in effect, a still-frame spectrum analyzer. You could also think of this
display as a (horizontal) plot of a vertical slice of the Spectrograph. For more informa-
tion, refer to The Frequency Slice on page 62.
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Spectrograph

View Menu > Spectrograph

Spectro
B i |

Keyboard Command = [S]

The Spectrograph is a topographical representation of the traditional “waterfall”
display. This “three-dimensional” plot puts time on the x-axis, frequency on the
y-axis, and represents amplitude using color. For more information, please refer to
The Spectrograph on page 64.

Channel

View Menu > Channel

=2

When a stereo wave file is open in the Analysis module, the Channel commands
select which channel (Left or Right) is displayed. If two stereo files are loaded, the
displayed channel for each file is selected independently — the Channel commands
apply to the wave file displayed on top. To view both channels of a stereo wave file
simultaneously, open the same file as both File 1 and File 2 then select the Right
channel on one copy and the Left channel on the other.

Time Zoom

Move Right / Left

View Menu > Time Zoom > Move Right / Left
Keyboard Commands:

Move Right = [Right Arrow]
Move Left = [Left Arrow]

When you are zoomed in on the horizontal (x-axis) range of the main plot, only a
portion of the wave file's full time range is displayed. These two commands move
the displayed range left or right to allow you to view the information before or
after the range currently displayed.
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Zoom In / Out

View Menu > Time Zoom > Zoom In/ Out

Keyboard Commands:
Zoom In = [Ctrl] + [Down Arrow]
Zoom Qut = [Ctrl] + [Up Arrow]

These two commands increase or decrease the horizontal (x-axis) “magnification” of
the Time Display, Time Slice and Spectrograph plots by decreasing the displayed time
range of the main plot. Note that when the time axis scale is changed, the boundaries
of the currently-displayed time range are indicated by range locator bars in the
Waveform display.

| Frame Range

0-170

In Time Display mode the precise sample range displayed in the Sample Range
readout to the right of the plot. In Time Slice and Spectrograph modes the Sample
Range readout is replaced by a Fframe Range readout that shows the FFT frame range
currently displayed. Clicking either of these readouts with your mouse will pop up a
dialog box allowing you to specify a time range in samples or FFT frame numbers
(depending on the display mode).

Mouse Shortcut: The time range for the Time Display, Time Slice and Spectrograph
display modes can also be set by clicking and dragging (horizontally) with the mouse
on the Waveform display. See page 100 for more information.

Amplitude
Zoom In / Out

View Menu > Amplitude > Zoom In/ Out
Keyboard Commands:

Zoom Out = [+]

ZoomIn = []

These two commands increase or decrease the vertical (y-axis) “magnification” of
the Time Display, Time Slice, and Frequency Slice plots by decreasing the displayed
amplitude/magnitude range.
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Move Up / Down

View Menu > Amplitude > Move Up / Down

Keyboard Commands:

Move Up = [Page Up]

Move Down = [Page Down]

When you are zoomed in on the vertical (y-axis) range of the main plot, only a portion
of the wave file's full amplitude range is displayed. These two commands move the

displayed range up or down to allow you to view the information above or below the
range currently displayed.

Note: To reset the range of any Analysis module plot to the program defaults, use the
Default Zoom command (see page 87).

Linear Scale

View Menu > Amplitude > Linear Scale

Keyboard Command = [Ctrl] + [L]

Sets the vertical (y) axis of the Time Display plot (only) to Linear amplitude scaling.
When Linear scaling selected amplitude values are given as a percentage of full scale
based on sampling resolution (bits per sample) at which the wave file was recorded.

Absolute Value Scale

View Menu > Amplitude > Linear Scale

Keyboard Command = [Ctrl] + [V]

Displays the A/D amplitude values on a linear scale with all negative values converted
to positive. Amplitude values are given as a percentage of full scale based on sam-
pling resolution (bits per sample) at which the wave file was recorded.

Decibel Scale

View Menu > Amplitude > Linear Scale

Keyboard Command = [Ctrl] + [D]

Sets the vertical (y) axis of the Time Display plot (only) to logarithmic amplitude
scaling. A/D amplitude units are converted to decibel values.
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Slice

I Frame
1 (0.02sec) S

hdi
The Slice commands are used to navigate between FFT frames and frequency
ranges in Frequency Slice and Time Slice modes (respectively). Note that you can
also navigate between bands/frames using the Band spinner that appears to the right

of the main plot in Time Slice mode or the Frame spinner that replaces the Band
spinner Frequency Slice mode.

Next Slice

View Menu > Amplitude > Slice
Keyboard Command = [Space Bar]

“Moves” the display to the next FFT frame or Time Slice (depending on the current
display mode).

Previous Slice

View Menu > Amplitude > Slice

Keyboard Command = [Shift ]+ [Space Bar]

“Moves"” the display to the previous FFT frame or Time Slice (depending on the
currently selected display type).

Go to Slice

View Menu > Amplitude > Slice

Keyboard Command = [Ctrl] + [G]

In Frequency Slice mode, this command opens a dialog box prompting you to select
an FFT frame for display by time or frame number.

Mouse Shortcut: You can select an FFT frame in Frequency Slice mode by placing the
mouse cursor on a point in the Waveform Display and clicking the left mouse button.

Loop Through Slices

View Menu > Amplitude > Slice

The Loop through Slices command displays all of the FFT frames calculated for the
wave file sequentially, returning to the beginning of the file when it reaches the end.
Repeating the Loop through Slices command toggles the feature off.
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Frequency
Zoom (1, 2, 3 and 4)

View Menu > Frequency > Zoom (1, 2, 3 and 4)

Zoom

|

ﬂ ﬂ ﬂ ﬂ Default |

Keyboard Commands = [1], [2], [3], or [4]

The numbered Frequency Zoom commands are used to select from the four preset
frequency ranges for the Frequency Slice and Spectrograph display modes. The range
of each Zoom is user definable and is set from the Zooms tab of the Options dialog
box. The frequency scale commands below set the type of frequency scaling used on
Frequency Slice and Spectrograph plots and as the resolution (bandwidth) of the Time
Slice display.

Narrowband

View Menu > Frequency > Narrowband

Keyboard Command = [5]

Sets the Time Slice display to Narrowband (single FFT bin) resolution.

Linear Narrowband

View Menu > Frequency > Linear Narrowband
Keyboard Command = [6]

Plots the frequency axis of the Frequency Slice and Spectrograph displays in Linear
frequency scaling.

Logarithmic Narrowband

View Menu > Frequency > Logarithmic Narrowband
Keyboard Command = [7]

Plots the frequency axis of the Frequency Slice and Spectrograph displays using
Logarithmic frequency scaling.
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Octave

View Menu > Frequency > Octave
Keyboard Command = [8]
Changes the Frequency Slice and Time Slice displays to octave band resolution.

1/3-Octave

View Menu > Frequency > 1/3-Octave
Keyboard Command = [9]
Changes the Frequency Slice and Time Slice displays to 1/3-octave band resolution.

Note: If octave bands in the Frequency Slice display appear “ghosted” at low frequen-
cies, it means the frequency resolution of the FFT is insufficient for the data in those
bands to be completely reliable. To increase frequency resolution, increase the FFT
size when transforming the wave file.

Mask

The Mask feature is useful when analyzing signals known to be contaminated by
persistent extraneous noise sources such as fluorescent lights, electric motors, etc.
Masking is applied in Frequency Slice mode but the effects are also visible on the
Spectrograph plot when Masking is active. See page 103 for more information on
setting up frequency masks in the Analysis module.

Use Mask

View Menu > Mask > Use Mask

Keyboard Command = [Ctrl] + [M]

To apply a mask, switch to Frequency Slice mode, select Narrowband resolution, and
select Use Mask to activate Masking. With the mouse, click and drag from left to right
to draw a horizontal line across the frequency range you wish to mask at the highest
magnitude you want to allow for those frequencies. When you release the mouse
button you will see the effect of the mask. Repeat this process for any other frequen-
cies you wish to mask.

After a mask has been created, you can add more frequencies at any time using the
same procedure. Repeating the Use Mask command toggles masking on and off. The
mask is kept in memory until you clear it (see below) or exit the Analysis module.
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Clear Mask

View Menu > Mask > Clear Mask
Keyboard Command = [Ctrl] + [Shift] + [M]

Clears all masking information from memory, allowing you to create an entirely new
mask (rather than adding to an existing mask).

File 2

The File 2 commands control the relative time offset for File 2 when two wave files
are open in the Analysis module. The Move (time offset) commands above are
enabled in Time Display mode only. Note that File 2 time offset may also be specified
(in samples) in the File Information dialog box.

Move Left

View Menu > File 2 > Move Left

Keyboard Command = [Ctrl] + [Left Arrow]

Fine (negative) time offset adjustment (moves the File 2 trace one pixel to the /eft).
Move Right

View Menu > File 2 > Move Right

Keyboard Command = [Ctrl] + [Right Arrow]

Fine (positive) time offset adjustment (moves the File 2 trace one pixel to the right).
Move Left Fast

View Menu > File 2 > Move Left Fast

Keyboard Command = [Ctrl] + [Shift] + [Left Arrow]
Coarse (negative) time offset adjustment for the File 2 trace.
Move Right Fast

View Menu > File 2 > Move Right Fast
Keyboard Command = [Ctrl] + [Shift] + [Right Arrow]
Coarse (positive) time offset adjustment for the File 2 trace.
Reset to No Shift

View Menu > File 2 > Reset to No Shift

Keyboard Command = [Ctrl] + [R]

Clears all time offset adjustment.

Page 84 SIA-Smaart Acoustic Tools Version 4 User Guide



Chapter 3: Analysis Module Functions and Commands

Cursor
Track Data

View Menu > Cursor >Track Data

With this option selected, the tracking cursor “snaps” to the top trace in the “Z" order
(see below), moving from data point to data point along the trace as you move the
mouse from left to right.

Move Left/ Right

View Menu > Cursor > Move Left/ Right

Keyboard Commands:
Move Left = [Alt] + [Left Arrow]
Move Right = [Alt] + [Right Arrow]

When the Track Data (see above) is enabled, the (Cursor) Move Left and Move
Right commands can be used to move the precision tracking cursor to the right
or left by one pixel or one sample or data point (depending on the display mode
and magnification).

Set FFT Center to Peak

View Menu > Cursor > Set FFT Center to Peak
Keyboard Command = [Ctrl] + [Alt] + [P]

The Set FFT Center to Peak command sets the center point for the first FFT frame to
be calculated by the Transform routine to the highest peak found in the wave file. A
marker will appear on the plot and in the Waveform Display to indicate the location of
the specified center point. The marker is initially a red and white striped line that
changes to a solid red line after the file has been re-transformed.

Normally, the Analysis module's Transform routine calculates the FFT series used

for frequency-domain displays beginning with the first sample in the wave file. One
potential problem with this is that the peak in the impulse response may fall at a point
in the FFT frame where it is attenuated by the Data Window function used in the
Transform routine.

All the data windows provided in the Analysis module attenuate the time-domain data
closest to the beginning and end of each FFT frame to the largest extent but leave the
samples closest to the center of the frame untouched for the most part. Setting the
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center point for the first FFT in the transform series on the initial peak in the impulse,
which normally represents the arrival of direct sound, ensures that the peak data is
altered as little as possible by the data window in the first FFT frame.

Move FFT Center Left
View Menu > Cursor > Move FFT Center Left
Keyboard Command = [Ctrl] + [Alt] + [Left Arrow]

Moves the selected FFT center point to the left by one pixel or one data point depend-
ing on the display "magpnification." If you are zoomed in on the time (x) axis to the
extent that individual data points are more than one pixel apart, the center point will
move one data point to the left.

Move FFT Center Right

View Menu > Cursor > Move FFT Center Right
Keyboard Command = [Ctrl] + [Alt] + [Left Arrow]

Moves the selected FFT center point to the left by one pixel or one data point depend-
ing on the display "magnification."

Clear FFT Center

View Menu > Cursor > Move FFT Center Right

Keyboard Command = [Ctrl] + [X]

Clears the FFT center point selection from the Time Display and resets the default
starting point for the Transform routine the first sample in the wave file.

Setting the FFT Center Point Using Your Mouse

You can also set/move the center point for the first FFT frame to any point on the Time
Display plot by holding down the [Ctrl] key while clicking on the plot with your mouse.

Notes:

There must be enough samples between the beginning of the file and the selected
FFT center point for the first half of the FFT. If the selected center point would cause
the first FFT to "overrun" the beginning of the wave file, the program will default back
to beginning the first FFT on the first sample in the wave file when the file is trans-
formed. The FFT center point can only be set/changed in Time Display mode.
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Change “Z" Order

View Menu > Change “Z" Order

Top Trace
P——— |

Keyboard Command = [Ctrl] + [F]

Cycles through the (z-axis) “stacking order” of all displayed traces. In other words,
when multiple traces are displayed, repeating this command will bring each trace in
turn to the “top of the stack.” This is useful for making the trace that most interests
you easier to see, but it is also how you assign which trace the precision cursor
tracks. When tracking is enabled, the precision always tracks the trace that is
displayed on top.

Default Zoom

View Menu > Default Zoom

Zoom

|
ﬂ ﬂ ﬂ ﬂ Default |
Keyboard Command = [Shift] + [Up Arrow]

Returns the both the X and Y axes of the plot to the default settings for the current
display mode (as defined on the Time Display, Slice, or Spectrograph tabs of the
Options dialog box).

Rainbow

View Menu > Rainbow

Rainhow

P

Keyboard Command = [R]

In Time Slice mode, pressing the Rainbow button displays three Time Slice traces
simultaneously; the “slice” for the selected center frequency plus two sidebands.
By default the sidebands are one octave or 1/3-octave up and down from the center
frequency depending on the resolution selected (Narrowband resolution is not
available for the Rainbow display). Specific (octave) center frequencies for all three
traces may be selected on the Rainbow tab of the Options dialog box.
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Normalized

View Menu > Normalized
Keyboard Command = [N]

The Rainbow display plot can be “normalized” so that all three Time Slice traces have
the same amplitude at a point you select. To simultaneously enable Normalized and
select the normalization point, hold down the [Shift] key while clicking on the plot
(typically near a peak on one of the traces) with the left mouse button. When Normal-
ize is on, two vertical white lines on the plot indicate the normalization point. To move
the normalization point, hold down the [Shift] key while clicking another on the plot.
Pressing the [N] key, or selecting the Normalized command from the View menu,
toggles normalization on and off.

Power Spectrum

View Menu > Power Spectrum

Power Sp.
pllthiis |

Keyboard Command = [P]

In Frequency Slice mode, the Power Spectrum command plots a single trace that
represents the average of all, or a specified range, of the frames calculated for a wave
file. The locator bars in the Waveform display above the main plot, and the FFT range
over which the power spectrum was calculated is shown in the Fframe Range readout
to the right of the plot.

I Frame Range

0-170

The time range over which the Power Spectrum is calculated may be specified, using
time coordinates or FFT frame numbers, on the Power Spectrum tab of the Options
dialog box or by clicking the Frame Range readout to the right of the plot and entering
arange of FFT frames in the pop-up dialog. Power Spectrum is a toggle command.
Repeat the command or click the Power Spectrum button again to return to the
normal, single-FFT Frequency Slice display.

Note: The mathematical technique used to calculate the Power Spectrum is an RMS
running average of the complex frequency data.
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Options Menu Commands

Most of the Analysis module’s user-configurable options and properties are set in the
Options dialog box. The Options dialog box is organized into 12 separate “pages” for
different types of settings. We also refer to these pages as “tabs” because each has
an index tab at the top that is always visible (in the top portion of the dialog box
window). To bring a page to the front when the dialog box is open, click on its tab.

The Options menu commands open the Options dialog box with the corresponding
tabbed page already on the top of the stack. There are also keyboard shortcuts to
some of the more frequently accessed tabs.

All

Options Menu > All

Options |

Keyboard Command = [Alt] + [0]

Opens the Options dialog box with the last tab used on top (any tab may be selected
any time the Options dialog box is open).

Calibrate

Options Menu > Calibrate

The Calibrate tab of the Options dialog box is used to calibrate multiple files to a single
amplitude/magnitude reference. This feature helps to simplify comparison of two files
and can be used to calibrate measurements stored in files to some external reference

for analysis or comparison purposes. There are three basic calibration options:

* (Calibrate to Current File — Sets the 0 dB point for all frequency-based displays
(Time Slice, Frequency Slice, and Spectrograph) to the highest value actually
found in the current wave file (or the file displayed on top if two files are loaded).

* Calibrate to Full Scale — Sets the 0 dB point for frequency-based displays to
the highest magnitude value theoretically obtainable given the wave file's sampling
resolution (8 to 24 bits per sample).

* Calibrate to Custom Level — Sets the 0 dB point for all frequency-based displays
to the level specified in the 0 dB field of the Custom Level section. Custom magni-
tude values are specified as “dB down” from the theoretical maximum for the file’s
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sampling resolution (8 to 24 bits per sample).

» Set Custom Level To Current File — Clicking this button plugs in the highest
magnitude value actually found in the current wave file (or the file currently
displayed on top if two files are loaded) as the 0 dB point for the custom
calibration option.

Color

Options Menu > Color

The SIA-Smaart Analysis module allows you to customize the colors of virtually
everything on the screen and even use your own bitmap files as a background. Color
and background options are loaded as sets called Color Schemes. Several ready-to-
use color schemes (including two with “metallic” bitmapped backgrounds) are
included with the program and you can easily define your own. The Colors tab of the
Options dialog box allows you to create, edit and manage Color Schemes for the
Analysis module program window and displays.

The Color Schemes section of the Colors tab has a list of all available Color Schemes
along with buttons for creating, editing, and deleting user-defined schemes. A pair of
list boxes below the Color Schemes section allow you to select separate color
schemes for display and printing purposes.

Color Schemes

Mew...

Clicking the Mew button calls the Edit Color Scheme dialog box, allowing you to create
a new color scheme. In this dialog box, you can change colors for various display
elements and optionally, a Windows bitmap (*.bmp) file to use as a background for
the program Window. Color selections initially shown in the dialog box for each
element are based on the Color Scheme currently in selected in the list.

Edit.. |

The Edit button calls the Edit Color Scheme dialog box to allow you to edit an existing
(user-defined) Color Scheme selected in the Color Schemes list.
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Delete |

Clicking this button deletes the user-defined Color Scheme selected in the list on
the left.

* Display Color Scheme — Selects an existing Color Scheme to be used for display
purposes (the colors shown on your computer screen).

* Printing Color Scheme — Selects an existing Color Scheme for use when printing
from the Analysis module.

Devices

View Menu > Devices

If your computer has more than one sound card (or driver set) installed, the Devices

tab of the Options dialog box allows you to select which devices the Analysis module
should use.

* Wave In — Selects the device to be used for audio recording.

* Wave Out — Selects the device to be used for audio output (wave file playback).
Frequency Zooms

View Menu > Frequency Zooms

Keyboard Command = [Z]

This section of the Options dialog box controls frequency ranges for the four
Frequency Zooms.

* MIN — Sets the lowest frequency displayed when the zoom preset is selected.

* MIAX — Sets the highest frequency to display. Entering the word “Nyquist” in this
field automatically sets the MAX frequency to the highest frequency obtainable at
the wave file's sampling rate (Nyquist Frequency (Hz.) = Sampling Rate + 2).
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Meters

Options Menu > Meters

The settings in the Meters tab of the Options dialog box control the appearance and
behavior of the Input Level Meters in the Record Wave File dialog box. The meters are
calibrated to regard the maximum digital output of the A/D system of the sound card
being used normally 16-24 bits) as 0 dB.

Peak Hold

* Peak Hold — \When this box is checked the input level meters will continue to
indicate the highest input level encountered in the input signal for a specified
period of time after the level drops.

* Hold Peak For — Specifies the length of time (in seconds) the meters hold peak
levels when Peak Hold (see above) is enabled.

Meter Colors

The input level meters in the Record dialog are designed to display three colors, the
normal “LED” color (Light Green for input 0 and Light Blue for input 1 when the default
Color Scheme is used) plus Yellow and Red. The meter “LEDs” will display input levels
in the normal LED color up to the amplitude threshold specified for Yellow, then Yellow
up to the threshold for Red, and Red above that level.

* Yellow if above — Sets the amplitude threshold at which the meter LED color
changes to Yellow.

* Red if above — Sets the amplitude threshold above which the meter LED color
changes to Red.

Appearance

Meter (Options for the appearance of the area immediately surrounding the meters).
* Raised — The meter area will appear to protrude from the background.

* Inset — The meter area will appear to be sunken into the background.

* Flat — The meter area will be indistinguishable from the background.
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LEDs (Options for the appearance of the meter “LEDs.”)
* Raised — The meter area will appear to protrude from the background.

* Inset — The meter area will appear to be sunken into the background.

LED Levels

The Analysis module allows you to specify amplitude values for each individual pair
(L/R) of “LEDs."” Meter scaling is independent of any display calibration setting. All
values must be given as a negative number of decibels (dB) where 0 dB is equal to the
maximum (digital) output amplitude of the selected wave-in device’s A/D section.

Power Spectrum

Options Menu > Power Spectrum

The default Power Spectrum, an average of all FFT frames calculated for a wave file, is
automatically computed when the wave file is transformed. You can change the time
range of the Power Spectrum at any time by specifying a custom range on the Power
Spectrum tab of the Options dialog box.

The beginning and end values for a custom range of FFT frames may be specified by
FFT frame number or by time coordinates. The Power Spectrum is recalculated for the
specified range when you click OK to exit the Options dialog box. If you entered the
range using time values, the Analysis module will adjust the time range specified to
coincide with the beginning and end of the closest FFT frames before recalculating.

Printing
Options Menu > Printing
The Printing tab of the Options dialog box controls the appearance and content of

pages printed directly from the Analysis Module. The following options are user-
definable:

Header

* Title (1, 2, and 3) — You can specify up to three lines of title text to appear in the
header section at the top of Analysis Module printouts. If any of the three Title
fields is left blank, that line is omitted on the printed page.
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Footer

* Note (1 and 2) — You can specify up to two lines of footer text to appear at the
bottom Analysis Module printouts. If either of the Note fields is left blank, that line
is omitted on the printed page.

* Print Today’s Date — If this box is checked, the current date (as set on your
computer) will be inserted in the title area at the top of the printout. If you want to
use a date other the current system date of your computer on the printout, un-
check this box and type the desired date as one of the Title lines.

Note: In addition to the note and date lines as specified in the Footer section above,
Analysis Module printouts will also include a final footer line with the notation
“Created by (User Name) using SIA Smaart.” The User Name will be the name of the

user to whom this copy of Smaart Acoustic Tools is registered. This line cannot be
edited or omitted.

» Show custom print dialog before print and print preview — \When this box is
checked, selecting either the or commands will open the Custom Print Information
dialog box to allow you to set title text and other options for the printout before
proceeding with the selected operation. The Custom Print Information dialog box
includes all of the same options as the Printing tab of the Options dialog box. If you
un-check this check box, the Analysis module will bypass the Custom Print
Information dialog box in Print and Print Preview operations and execute the
selected command immediately.

Rainbow

Options Menu > Rainbow

The Rainbow tab of the Options dialog box has the following options for the Time Slice
Rainbow display feature.

* Center Frequency +/— 1 side band — \When this option is selected, the Rainbow
display plots the “Time Slice” for the selected center frequency plus two sidebands
one octave or 1/3-octave up and down from the center frequency depending on the
resolution selected (Narrowband resolution is not available for the Rainbow
display).

* Specific frequencies — Selecting this options allows you to select three specific
(octave) “Time Slices” to be displayed when the Rainbow feature is enabled.

Page 94 SIA-Smaart Acoustic Tools Version 4 User Guide



Chapter 3: Analysis Module Functions and Commands

Slice

Options Menu > Slice

The Slice tab of the Options dialog box provides the following options controlling the
appearance and behavior of the Time Slice and Frequency Slice displays.

Time Slice

* Center Frequency — Sets the center frequency for the Time Slice plot (the center
frequency can also be changed using the Next Slice and Previous Slice com-
mands).

Frequency Scale:

* Narrowband — Sets the Time Slice plot to narrowband (single FFT point) resolu-
tion.

* 1/3-0Octave — Sets the Time Slice plot to octave-band resolution.

* Octave — Sets the Time Slice plot to 1/3-octave-band resolution.

Amplitude Range:

* Max — Sets the upper end of the displayed magnitude (y-axis) range of the plot.
* Min — Sets the lower end of the displayed magnitude (y-axis) range of the plot.
Frequency Slice

Frequency Scale:

* Linear — Displays the Frequency Slice plot using linear frequency scaling.

* Log — Displays the Frequency Slice plot using logarithmic frequency scaling.

1/3-0ctave — Displays the Frequency Slice plot using 1/3-octave frequency
scaling.

* Octave — Displays the Frequency Slice plot using octave-band frequency scaling.
Amplitude Range:

* Max — Sets the upper end of the displayed magnitude (y-axis) range of the
Frequency Slice plot.

* Min — Sets the lower end of the displayed magnitude (y-axis) range of the
Frequency Slice plot.
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Spectrograph

Options Menu > Spectrograph

The Spectrograph tab of the Options dialog box contains a number of options that
control the appearance and behavior of the Spectrograph display.

Bar Width

The Spectrograph is made up of vertical bars representing each FFT frame that falls
within the displayed time range. The vertical bars are divided into sections represent-
ing individual FFT data points. The following options control the way these individual
sections of the vertical bars are plotted.

Uniform — This option displays the Spectrograph as a continuous color map with
each vertical bar having a uniform width from top to bottom.

Relative — Varies the (horizontal) widths of individual sections in the vertical bars
plotted relative to their magnitude value (higher magnitude values are wider).

Colors

Dynamic Range — This value sets the magnitude range included in the file-based
Spectrograph display only. All magnitude values in the Spectrograph display are
given as “dB down” from zero so specifying a dynamic range of 50 plots a magni-
tude range from 0 dB to —50 dB.

Number — Selects the number of colors to use in the Spectrograph plot (from 8 to
236 depending on your display hardware and drivers). This setting, along with the
Dynamic Range, also determines the number of decibels represented by each
color.

Min — Selects the color used to represent the minimum magnitude value(s)
shown on the Spectrograph plot. Clicking the colored square opens a standard
Windows Color dialog box enabling you to choose a different color for the lowest
value(s).

Max — Selects the color used to represent the maximum magnitude values shown
on the Spectrograph plot. Clicking on the colored square opens a standard Window
Color dialog box enabling you to choose a different color for the highest value(s).

Default — The Default button resets the Min and Max color selections to the
program defaults.
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* Gray — Plots the Spectrograph using shades of gray rather than colors.
This option is useful for monochrome displays or for printing purposes.

Note: The Analysis module automatically generates the colors in the spectrum
between the specified Min and Max colors using Hue, Lightness and Saturation
(HLS) calculations.

Frames

The options listed in this section enable you to specify a time range for the Spec-
trograph display using FFT frame numbers (rather than the Time Zoom commands).

» All — Displays all the FFT frames calculated for a wave file to show the entire time
range of the file.

* Custom — Enables the two edit fields to the right, allowing you to specify starting
and ending FFT frame numbers for a custom time range you wish to display.

Frequency (Y) Scale

* Linear — Displays the frequency (y) axis of the Spectrograph plot on a /inear
scale.

* Log — Displays the frequency axis of the Spectrograph plot on a logarithmic scale.

Note: Calibration for all frequency-based display modes in the Analysis module
(i.e., all display modes except Time Display) is now set from the tab of the Options
dialog box.
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Time Display
Options Menu > Time Display
The Time Display tab of the Options dialog box provides the following controls for the
appearance and behavior of the Time Display plot.
Amplitude Scale
* Linear — Displays the amplitude (y) axis of the Time Display plot on a linear scale.

* Absolute Value — Displays the amplitude (y) axis of the Time Display plot ona
linear scale with all negative values converted to positive.

* Decibel — Displays the amplitude (y) axis of the Time Display plot on a logarith-
mic (decibel) scale.
Amplitude Range

The Amplitude Range controls allow you to set both the Current and Default amplitude
range to be displayed on the Time Display plot.

* Max — Sets the upper end of the displayed amplitude (y-axis) range of the plot.
* Min — Sets the lower end of the displayed amplitude (y-axis) range of the plot.

Show Delta Cursor In

Time values in the Analysis module can be displayed in any combination of time,
samples, or distance equivalents depending on which of the following four options is
selected.

* Time — Displays the horizontal difference in seconds.

* Feet— Displays the horizontal difference in feet.

* Meters — Displays the horizontal difference in meters.

» Samples — Displays the horizontal difference in samples.

Speed of Sound — The Analysis module uses the Speed of Sound setting to
calculate distance equivalents for time values. The speed of sound value can be
specified in either feet or meters, depending on which unit of measure is selected
(see above). The default speed of sound value is 1120 feet per second or 341.359
meters per second.
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Waveform
Options Menu > Waveform

The Waveform tab of the Options dialog box contains the following options for
controlling the amplitude range of the Waveform Display.

Amplitude Zoom

* None — Displays an amplitude range representing +/— 100% of the maximum
possible amplitude given the wave file’s digital resolution (4+/— 127 for an 8-bit file,
+/— 32k for a 16-bit file).

* Peak to Peak — This option scales the y-axis scale of the Waveform Display equal
to the largest (4/—) amplitude values actually encountered in File 1.

* Custom — Allows you to set a custom amplitude range for the Waveform Display
using the two edit fields. The minimum (Min.) and maximum (Max.) values for the
amplitude range are specified as a percentage of the maximum amplitude values
possible given the wave file's digital resolution.

Default On Open

* None — Selects “None” (full scale) as the start-up default amplitude scaling for
the Waveform Display.

* Peak to Peak — Selects Peak-to-Peak (see above) as the start-up default ampli-
tude scaling for the Waveform Display.

Set All Options to Default
Options Menu > Waveform

Returns all user-configurable settings, with the exception of the Color Scheme and
Device selections, to the Analysis module’s “factory” defaults.
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Mouse Procedures

Most Analysis module functions can be accessed several different ways (e.g., menu
commands, on-screen controls or hot keys). Some of these also have mouse short-
cuts and there are a few functions that can only be accessed using your mouse (or
other pointing device). This section details the Analysis module’s most important
mouse procedures and shortcuts:

* Time Range Selection (Time Display, Time Slice and Spectrograph modes)

Select/Change (First) FFT Center Point (Time Display mode only)

Select Normalization Point for Rainbow Display (Time Slice mode only)

Manual Delta/Decay Rate Calculation (Time Slice and Time Display modes)

FFT Frame Selection (Frequency Slice mode only)
» Masking (Frequency Slice mode)

Time Range Selection

In Time Display, Time Slice and Spectrograph modes, the main plot can display
the entire wave file time range or any portion thereof. Vertical Range Locator bars
in the Waveform display show the boundaries of the time range currently displayed.

To select a specific portion of the time range for display using your mouse, place
the mouse cursor over the point on the plot in the Waveform display where you
want the displayed range to begin and hold down the left mouse button.

1 1
0.000 0.250 0.000 0.250 0.000 0.250

Drag the cursor to the right or left until you reach the point where you want the
displayed range to end (a “rubber band” box will appear in the Waveform display
to show your progress) and release the mouse button.

After you release the mouse button, the Range Locator Bars will snap to the bound-
aries of your selection and the main plot will change (zoom in or out) to display only
the time range you selected. Clicking in the area outside the plot in the Waveform
Display with the left mouse button or pressing [Shift] + [Up Arrow] on the keyboard
will return the time range to the full extent of the wave file.
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Select/Change (First) FFT Center to Peak

Setting the center point for the first FFT in the transform series on the initial peak in
the impulse response ensures that the peak data is altered as little as possible by the
data window function in the first FFT frame. All of the data windows provided in the
Analysis module attenuate the samples closest to the beginning and end of each FFT
frame to the largest extent, leaving the samples closest to the center of the frame
untouched for the most part. To set or move the center point for the first FFT frame to
any point on the Time Display plot, hold down the [Ctrl] key while clicking on the plot
with your mouse. To reset the first FFT starting point to the beginning of the wave file,
hold down the [Ctrl] key while clicking off the plot anywhere in the margins of the plot
area. To clear the FFT center point selection press [Ctrl] + [X].

Note that specifying the first FFT center point only works if are enough samples
between the beginning of the file and the selected FFT center point for the first half
of the FFT. If the selected center point would cause the first FFT to "overrun" the
beginning of the wave file, the program will default back to beginning the first FFT
on the first sample in the wave file when the file is transformed.

Select/Change Normalization
Point for Rainbow Display

The (Time Slice mode) Rainbow
display plot can be “normalized”
so that the three Time Slice
traces have the same amplitude
at a point you select. When
Normalize is on, two vertical
white lines appear on the plot

to indicate the normalization
point. To move the normalization
point, hold down the [Shift] key while clicking on the plot (typically near a peak
on one of the traces) with the left mouse button. Pressing the [N] key toggles
normalization on and off.

* 1000 Hz
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Delta/Decay Rate Calculation

In Time Slice mode you can use your
mouse to calculate the decay rate for
an impulse response recorded in a
wave file. The same procedure can
be used to find the time and ampli-
tude difference between two points
in the Time Display mode.

To perform this procedure, place your
mouse cursor at the point on the plot
where you wish to begin the decay
rate calculation. Hold down the left
mouse button and drag the cursor to draw
(“rubber band”) a line to the desired end point.

(0.5800 sec, -24.00 dB), Slope=-41.38 dB/sec, TE0=1.4 sec

The line you draw remains visible on the plot when you release the mouse button. The
relative time and amplitude difference between the end points of the line, the decay
slope in dB per second, and equivalent RT60 value will be displayed in the relative
cursor readout above the Waveform display to the right of the tracking cursor readout.
To clear the line, click once on the plot with your left mouse button.

FFT Frame Selection in Frequency Slice Mode

| |
0.000 0.250 0.00o 0.250

In Frequency Slice mode, two vertical striped Frame Locator bars in the Waveform
display indicate the time position of the FFT Frame currently displayed in the plot area.
To select a different FFT frame for display using your mouse, place the mouse cursor
over any point in the Waveform Display and click the left button once. The Frame
Locator Bars will move to the new location and the data from the selected FFT frame
will be displayed on the main Frequency Slice plot.
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Frequency Masking

Frequency Masking is useful
when analyzing signals known

to be contaminated by persistent
extraneous noise sources such

as fluorescent lights or electric
motors. Masking is applied in
Frequency Slice mode but the
effects of the mask are also visible
on the Spectrograph plot when
Masking is on.

To create a mask, in Frequency
Slice mode, first select Narrowband
resolution and press [Ctrl] + [M]
(or select Use Mask (under Masking
in the View menu) to activate Masking. With the mouse, click and drag from left to
right to draw a horizontal line across the frequency range you wish to mask at the
highest magnitude you want to allow for those frequencies.

When you release the mouse button you should immediately see the effect of the
mask. Repeat this process for any other frequencies you wish to mask. You can add
more frequencies to the mask at any time using the same procedure. The mask is
kept in memory until you clear it (using the Clear Mask command) or exit the
Analysis module.
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The following is a list of the Analysis module’s keyboard accelerators, or “hot-keys.” While
there are alternate ways of accessing virtually all of these functions, learning the keyboard
accelerators can significantly speed your work if you use the Analysis module extensively.

Key names on the list below are enclosed in [brackets] to differentiate them from descriptive
text. Some commands use more than one keystroke, for example the accelerator for the
Transform command is “[Ctrl]] + [T].” This means you must hold down the Control key while
you press the T key. For three-key accelerators, you would hold down the first key while

pressing the third

Amplitude

[+/=] = Amplitude (Y) Zoom Qut

[-] = Amplitude (Y) Zoom In

[PgUp] = Move Amplitude Range Up
[PgDn] = Move Amplitude Range Down
Time Display

[Ctrl] + [D] = Decibel Amplitude Scaling
[Ctrl] + [L] = Linear Amplitude Scaling

[Ctrl] + [V] = Absolute Value Amplitude
Scaling

[Ctrl] + [Alt] + [P] = Set FFT Center to Peak

[Ctrl] + [Alt] + [Left Arrow] = Move FFT
Center Point Left

[Ctrl] + [Alt] + [Right Arrow] = Move FFT
Center Point Right

[Ctrl] + [X] = Clear FFT Center

[Ctr]] + Mouse click outside plot = Clear
FFT Center Point Selection

Mouse: [Ctrl] + Clicking on Time Display
plot to set/move first FFT center point.

Audio

[Shift] + [P] = Play wave file
Cursor

[Alt] + [Right Arrow] = Move Right
[Alt] + [Left Arrow] = Move Left
Display

[D] = Time Display

[F] = Frequency Slice

[S] = Spectrograph mode

[T] = Time Slice Mode

[P] = Power Spectrum (Frequency Slice
mode only)

[R] = Rainbow Display (Time Slice only)

[N] or [Shift] + click on (Time Slice )
Rainbow Display plot = Normalize

File

[Ctrl] + [0] = OpenFile 1
[Ctrl] + [P] = Print

[Ctrl] + [T] = Transform
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File 2

[Shift] + [Ctrl] + [L] = Close File 2
[Shift] + [Ctrl] + [0] = Open File 2
[Ctrl] + [F] = Change "Z" Order

[Ctrl] + [R] = Reset to No Shift
(clear time offset)

[Ctrl] + [Left Arrow] = Move (File 2) Left
(negative time offset, fine adjust)

[Ctrl] + [Right Arrow] = Move (File 2) Right
(positive time offset, fine adjust)

[Shift] + [Ctrl] + [Left Arrow] = Move Left
Fast (negative time offset, coarse adjust)

[Shift] + [Ctrl] + [Right Arrow] = Move
Right Fast (positive time offset, coarse
adjust) Frequency

[1] = Select Frequency Zoom Range 1

[2] = Select Frequency Zoom Range 2

[3] = Select Frequency Zoom Range 3

[4] = Select Frequency Zoom Range 4

[5] = Narrowband Frequency Banding

[6] = Narrowband Linear Frequency Scaling
[7] = Narrowband Log Frequency Scaling
[8] = Octave Frequency Scaling/Banding
[9] = 1/3-0ctave Scaling/Banding

Notes:

Mask

[Ctrl] + [M] = Enable/Disable Masking
[Shift] + [Ctrl] + [M] = Clear Mask
Options

[Alt] + [0] = Options

[Alt] + [S] = Spectrograph Options
[Alt] + [Z] = Zoom Options

Slice

[SpaceBar] = Next Slice

[Shift] + [SpaceBar] = Previous Slice

[Ctrl] + [G] = Go To Slice (Frequency
Slice only)

Mouse Shortcut: Click in Waveform Display
Time Zoom

[Up Arrow] = Time zoom out

[Down Arrow] = Time zoom in

[Left Arrow] = Move Time Range Left
[Right Arrow] = Move Time Range Right

[Shift] + [Up Arrow] = Default Zoom (zoom
out to full time scale)

Mouse Shortcuts:
Click/drag in Waveform Display to
select range

Click off plot in Waveform Display
to clear zoom

Not all keyboard commands are active in all display modes.

Keyboard accelerators are a subset of the menu commands. Please refer to Analysis Module
Commands, beginning on page 68, for complete command descriptions.
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This section is intended to present “real-world” definitions of some of the basic
concepts and terminology used by SIA-Smaart software products. The definitions
given here are accurate with regard to SIA-Smaart, but should not necessarily be
considered comprehensive or mathematically complete. We have provided a list of
reference titles at the end of the section for those who wish to find a more in-depth
treatment of the topics discussed here.

Percentage Articulation Loss of Consonants (%ALCons)

This index was traditionally measured using long word lists and a set of listener
scoring tables. The %ALCons value can be calculated from the impulse response

or energy time curve two ways, using either a long or short method. The long form
calculation includes the ambient noise condition. The short form calculation does
not. The %ALCons calculation, particularly the short form calculation, which ignores
noise conditions, tends to give results that are very generous compared to more
rigorous standards such as STI. %ALCons values between 0 and 4.0 are considered
good, 12 to 4 percent are fair, below 12 is considered poor.

Clarity Factor (Cn)

The acoustical quantity of Clarity is the ratio of the early sound to late sound. The
division between early and late sound is given in milliseconds and expressed as Cn,
where n is a number of milliseconds (e.g., C10, C20, C50, etc.). For example, C50 is
a decibel energy ratio of the sound arriving within 50 milliseconds of the direct sound
compared to the overall reverberant decay. This tends to be one fairly accurate
predictor of subjective intelligibility. Clarity values above 5 are considered good,

-2 to 5 is fair, values below -2 are considered poor.

The default Clarity factor for the Intelligibility module is C50. Other commonly used
Clarity factors include C35 and C7. You can change the Clarity factor to anything you
like by a by changing the number of milliseconds in the Clarity field on the Graph tab
of the Options dialog box.
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Data Window Functions

Data Window functions help to reduce truncation errors arising from the segmenting
of longer data series into FFT frames. Remember that the Fast Fourier Transform (FFT)
requires a data series of finite length. The value of the samples immediately before
and after the data series used in the FFT are unknown and this can lead to certain
anomalies in the Fourier transform results.

All data windows types operate under the same basic principle. They “de-weight” the
samples nearest to the beginning and end of the FFT data series to help reduce these
truncation errors, or “edge effects.” The only real difference between different the
Data Window types is the “shape” of the “window.” The Analysis module provides
several different Data Window options including Hanning, Hamming, Blackman,
Blackman-Harris, Parzen and Welch. The option labeled “None,” for no data window
(also called a “rectangular” window), should be avoided for most applications.

Decibels

The decibel (dB) is a unit used to express the logarithmic ratio of two amounts of
power, voltage or any two values. Typically decibels are used when the two values
may differ over a very large range. The need for logarithmic scales in acoustics and
audio is a result of the wide range of sensitivity to sound intensities, frequencies and
pressures that makes up the range of human hearing. For example, a decay of 60 dB
represents a sound that has decayed by one million times in terms of energy! Most
measurements in audio are based on either voltage or sound pressure and are
expressed in decibels. The key point to understanding the decibel is that it is used to
describe a comparison of two values.

Two useful points regarding decibels to remember:

* Decibels are always a ratio of one value to another. You must know the reference
value in order to calculate the decibel values.

* 0dB can mean several different things (hence much of the confusion with decibels).
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For our purposes, in the context of SIA-Smaart Acoustic Tools, 0 dB means:

1. The input and output, or two inputs are equal in level for a given frequency, as in a
Transfer Function display, or

2. The highest level that can be reached. This usage applies to the Input Level Meters,
where a signal greater than 0 dB represents overload, and the Analysis module’s
Spectrograph display mode where all magnitude values are represented as “dB
down” from zero.

In the case of the Input Level Meters, 0 dB represents a value equal to the maximum
input voltage allowed by the sound cards’ A/D converter. The range of the meters is
set as a negative number of decibels relative to this value. Similarly, the dynamic
range of the Spectrograph display is specified as a negative number of dB relative to
the maximum digital amplitude resolution of the waveform file.

Note: For many sound cards, the maximum A/D converter input voltage is user-
selectable. Check your sound card documentation and utilities for more information.

Direct to Reverberant Level

This is simply the amplitude difference between the level of the direct sound and the
level of the top of the reverberant decay stage of the impulse response. This value is
expressed in decibels and is of interest in both broadband and band-limited decay
curves as it can play an important part in overall system intelligibility. There is no real
benchmark for this value other than that higher numbers are better.

Energy Time Curve (ETC)

The ETC is the envelope of the decay of a system. The ETC is mostly used to look at
reflections and decay rates of a system'’s response. The ETC is similar in some ways
to the SIA-Smaart Analysis module’s Time Slice display, however the ETC is calcu-
lated by using the Hilbert transform on the time-domain impulse response data
whereas the Time Slice is calculated using a frequency-domain representation of

a system’s impulse response.
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Fast Fourier Transform (FFT)

The Fast Fourier Transform (FFT) is a special case of the Fourier Transform, a math-
ematical technique used to transform time-domain data into frequency-domain data.
The output of the transform is a set of complex numbers representing both frequency
and phase information about the original time series. The term Fast Fourier Transform
comes from the fact that if you specify the time-domain data to contain a “power of
2" samples, the transformation can be calculated very quickly by digital computers.
Powers of 2 are the values of 2", where n is an integer (1, 2, 3, etc.).

Examples: if nis: the power of 2 (2") is:
8 256
9 512
10 1024
11 2048
12 4096

All frequency transformations in SIA-Smaart are FFTs and require the time record
to be a power of 2 (samples) in length. For long files and real-time operations,
SIA-Smaart will do the frequency domain transformation in pieces (frames), each
a power of 2 (samples) in length.

Note: It is certainly possible to calculate the Fourier Transform for a time record with
any number of samples. But when the number of samples is not a power of 2, the
number of calculations required can become very large. (On a PC, this could result

in a very slow Fourier Transform.)

Frequency Resolution

The frequency resolution of an FFT is calculated from the sampling rate and FFT size.
For a given FFT size, the frequency resolution of the FFT will be equal to the sampling
rate, divided by 2 (the Nyquist frequency), divided by half the FFT size. This means
that the data points along a frequency plot are distributed evenly along the frequency
axis every “Q" Hertz, where Q is the frequency resolution. For example, sampling at
44,100 Hz gives you a Nyquist frequency of 22,050 Hz. An FFT size of 1024 yields
512 frequency data points. Divide 22,050 by 512 to get a frequency resolution of
43.07 Hz. This means that there is one data point every 43.07 Hz.
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The table below shows frequency resolutions for some typical sampling rates and

FFT sizes:
Sampling Rate FFT size (in samples) Frequency Resolution
44100 Hz 2048 21.5Hz
44100 Hz 1024 43.0 Hz
22050 Hz 2048 10.7 Hz
22050 Hz 1024 21.5Hz
11025 Hz 4096 2.6 Hz

Increasing the FFT size, or decreasing the sampling rate will increase the frequency
resolution. Notice that both of these actions increase the time it takes to collect a
group of samples. This is the real key to increasing frequency resolution.

Note: A linear distribution of FFT points, where there is one point every n Hertz, yields
much better resolution at higher frequencies than at lower frequencies. In octave or
fractional octave band display modes, the Analysis module will display low bands for
which the frequency resolution is insufficient to resolve the band’s frequency data as
“ghosted.”

Impulse Response

You could think of the impulse response as the “signature” of a system (e.g., a room
and/or electroacoustic system). For our purposes, we can define the impulse re-
sponse as the signal that describes the changes a test signal undergoes as it passes
through a device or system under test. The broadband impulse response contains a
wealth of information about the system including the delay through the system,
frequency response, reflections, reverberation and decay. In fact, it is actually
possible to use the impulse response as a filter to convolve a “dry” signal, such as
speech or music, and hear what it would sound like if actually played through the
same system.
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Linear and Logarithmic Scales

In SIA-Smaart, both time and frequency plots may be viewed using either linear or
logarithmic (amplitude or frequency) scaling. A linear scale plots the frequency or
amplitude range linearly across the plot. On a linear frequency scale display, each
unit of measure (e.g., Hertz) covers the same distance on the axis. On a logarithmic
frequency display, each decade (power of ten), decibel, or octave (depending on the
type of information displayed) covers the same amount of the axis.

For example, on a linear frequency plot covering the range or 20 Hz to 20 kHz, the
entire right half of the plot would be devoted to the range of 10k to 20k, a single
octave. On a logarithmic scale each decade: 10-100, 100 -1k, 1k - 10k, etc. would
occupy an equal amount of the axis. 100 to 1000 Hz, a range of 900 Hertz covers
the same distance on the plot as 1 k to 10k, ten times the number of Hertz.

Both linear and logarithmic scales (for frequency and amplitude) have their advantages.
The choice of log or linear plots is based on experience and personal preference. The
human ear hears logarithmically in frequency, however many people feel that harmonic
structures and comb filters can be seen more easily on a linear display. SIA-Smaart
Acoustic Tools allows you to switch between logarithmic and linear displays easily

to find the type of plot that helps you best understand your data.

Maximum Length Sequence (NILS)

A Maximum Length Sequence (MLS) is a type of pseudorandom noise generated
using a system of bit-shift registers and a known group of “seed” numbers. An MLS
sequence is almost always a power of 2 (64, 128, 256, 512...) samples in length
however this is not an absolute requirement. One attractive feature of MLS is that it
is repeatable noise. Starting with the same seed numbers the same exact sequence
can be generated any number of times. Also, when an MLS sequence (or string of
MLS sequences) is played through a system under test and the results recorded, the
measured results and the MLS seed numbers can be entered into a calculation called
the Hadamard transform to calculate the impulse response of the very efficiently.
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Octave-Band Resolution

Octave-band resolution provides a combination of logarithmic and linear frequency
scales. On this type of display, each octave is represented as an equal width along the
frequency axis. This correlates with human hearing, where each octave appears to
sound like an equal interval, even though the number of Hertz doubles between each
increasing octave! In SIA-Smaart, octave band values are derived from FFT data. The
lowest bands appear as “ghosted” images (or are not shown) when the frequency
resolution is insufficient for the data to be reliable (see Frequency Resolution).

Octave and fractional-octave resolution plots are often simpler to read than narrow
band frequency data and can be useful for getting a quick overview of a signal.

Pink and White Noise

Pink and white noise are sounds or audio signals containing random (or pseudoran-
dom) broadband energy. Both are commonly used as signal sources in audio testing.
The difference between pink and white noise is obvious if you look at both using an
RTA. Pink noise appears flat on an octave- or 1/3-octave band display, because it has
equal energy per octave.

Octave Scale Octave Scale

-30- -30-
9 4. 9 4.
2 2
g -50. g -50-

-60- -60-

32 63 125 250 500 1K 2K 4K 8K 16K 32 63 125 250 500 1K 2K 4K 8K 16K
Frequency (Hertz) Frequency (Hertz)
Pink noise on an octave band display. White noise on an octave band display.

White noise will appear to be sloping upward to the right on the same display
(increasing in magnitude at higher frequencies). White noise has equal energy per
frequency so each higher octave has 3 dB more energy than the octave below it.

In fact, white noise has so much high frequency energy it can damage loudspeakers
if used improperly. We recommend exercising great care when using it as a test
signal for most electroacoustic measurement applications. When making an MLS
measurement, keep in mind that the MLS stimulus signal is essentially white noise.
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Schroeder Reverse Time Integration

Sometimes called Schroeder Inverse Integration, this is a technique for finding the
decay rate of a room, first published by Manfred Schroeder. Before personal comput-
ers were powerful enough to calculate the actual impulse response of a system (using
techniques such as MLS or a dual-FFT transfer function), Schroeder, et. al., suggested
that a way to make measurements of reverberant decay in large halls was to use an
impulsive source, record the data using a strip chart recorder, and integrate the decay
by summing the energy, starting at infinity and working backward in time.

Speech Transmission Index (STl and RSTI)

This type of measurement is based on the assumption that human speech is essen-
tially a fundamental waveform modulated by low frequency signals, STl uses the
Modulation Transfer Function (MTF) for several octave bands to try and predict the
ability of a system to convey spoken information. The MTF can be measured using a
special speech-like amplitude-modulated test signal or calculated from the broadband
system impulse response (the SIA Intelligibility module uses the latter method). STl is
expressed as a value between 0 and 1 where 0 means completely unintelligible and 1
means perfect intelligibility, STl values above 0.7 are considered good to excellent.
Values from 0.45 to 0.7 are fair, and values below 0.45 are poor.

The Rapid Speech Transmission Index (RSTI) is a shorter version of the STl calculation
that uses data from just the 500 Hz and 2000 Hz octave bands. RSTI tends to yield
slightly higher numbers then the more rigorous STl calculation which takes into
account almost the entire audible spectrum.

Sampling Rate

The sampling rate in digital audio is the number of times per second an analog audio
signal is sampled and digitized. The most important practical consideration is that the
sampling rate limits the frequency content of the signal being digitized. A general rule
is that sampling rate should be at least double the number of Hertz in the highest
frequency you want to include in the digitized signal. The frequency that is equal to
one half of the sampling rate is called the Nyquist frequency.

Some other issues affect the highest frequency you can accurately measure in
sampled signals. In theory, you can measure to half the sampling frequency but
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in practice things like aliasing, Sigma/Delta conversion and anti-aliasing filters make
frequencies close to the Nyquist tricky to measure.

Compact discs run at a standard sampling rate of 44.1 kHz. Professional digital audio
recording machines often sample at 48 kHz. Computer sound cards generally run

at one of several user-selectable sampling rates such as 44.1 kHz, 22.05 kHz or
11.025 kHz. The SIA-Smaart Intelligibility module determines the available sampling
rates by polling your computer’s sound card each time it loads. Currently, the fastest
sampling rate supported by any SIA-Smaart program module is 48 kHz.

General Rule: The higher the data sampling rate, the higher the frequency content
of the digitized signal. However higher sampling rates also mean more data to be
calculated, and possibly stored, in a given period of time.

Transfer Function

The transfer function is a complex comparison of two signals, typically a reference
signal and a measurement signal. Most commonly, this comparison is made between
the input and output of a device or system, such as an equalizer, sound system, or
room. When recording an impulse response measurement using the Dual FFT
method, the SIA-Smaart Intelligibility module records two channels of audio data,
transforms the data using FFTs, and calculates the transfer function of the two input
signals in the frequency domain. The results of the transfer function calculation are
then transformed (using an inverse FFT) and displayed in the time domain to show the
impulse response of the device or system under test.
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Glossary of Audio and Acoustics Terms

Analog to Digital (A/D) Conversion: The process of digitizing an analog signal. This
process almost always involves limiting the frequency content of the digitized signal.

Absolute Value: For any real number, the Absolute Value is the unsigned magnitude
of the number. Example: the absolute value of -3, denoted |-3| = 3.

Amplitude: The size of a real number (e.g., a number of volts), in either the positive
or negative direction. The term amplitude typically refers to numbers that are not
complex or plotted on a logarithmic scale, such as the numbers stored in the A/D
process.

Attenuation: A decrease in the level of a signal. Attenuation can refer to reduction in
level for a specified frequency range or a decrease in the overall level.

Clarity: The acoustical quantity of Clarity is defined as the ratio of the early sound to
late sound. The division between early and late sound is given in milliseconds and
expressed as Cn where n is a value in milliseconds, e.g., C10, C20, C50, etc.

Coherence: A mathematical function which represents the linearity between two
signals. The coherence is dependent on both signals and the number of averages
taken. The coherence value is calculated in the frequency domain and yields a value
between 0 and 1 for each frequency.

Compressors: Electronic devices that cause changes in gain (typically attenuation)
as a function of the input level. These devices should NOT be used when making
transfer function or impulse response measurements.

Crosstalk: Undesired energy in one signal (or channel) appearing from an adjacent
signal or channel.

Data Window: A mathematical function used to smooth the negative effects of
truncation that occurs when a finite number of FFT points are used to transform time
domain data into the frequency domain. The Data Window(s) reduce the amplitude of
the time domain data at the ends of the sample to be transformed.

Decay Rate: The rate at which a signal decays (diminishes in magnitude), usually a
function of frequency and expressed in either decibels per second, or relative to the
amount of time that would be required for the signal to decay 60 decibels at the given
rate of decay. (see Reverberation Time)
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Decibel: The decibel, often abbreviated as dB, is a logarithmic ratio between two
values. In acoustics, decibels most commonly refer to the ratio of an input level to the
output level of a system, or a given level compared to a fixed reference.

Dynamic Range: The difference in level between the highest and lowest signal a
system can accept or reproduce.

Early Decay Time (EDT): An acoustical quantity which is the time required for a
system, typically a room, to complete the earliest stage of its decay, typically the first
10 decibels. The Early Decay Rate can be expressed in units of decibels per second,
or relative to the amount of time that would be required for the signal to decay 60
decibels at the given rate of decay.

FFT: The Fast Fourier Transform is a mathematical technique used to transform time
domain data into the frequency domain. The term “Fast” refers to the fact that when
the number of time domain samples is a power of 2 (16, 32, 64, 128, 256, et al.) the

calculations can be performed very quickly by a digital computer.

Latency: The delay through a given unit or system. Latency is often referred to as the
throughput delay of a device. It is typical for digital delays to have a small latency even
when they are set to zero time delay.

Linear Scale: The term linear, refers to a set of values or scale of a graph on which
values are evenly spaced. On a linear scale, each value (or unit) has equal dimension.

Logarithmic Scale: A scale where each power of a given number (e.g., ten) is given
equal dimension.

Magnitude: A number assigned to a quantity so that it may be compared with other
quantities. For complex quantities, the magnitude is the square root of the sum of the
squares of the real and imaginary parts.

Nyquist Frequency: In digital audio, the Nyquist frequency is one half of the sam-
pling rate. The Nyquist frequency represents the highest frequency contained within a
signal sampled at a given sampling rate.

Octave-Band Resolution: Octave band resolution combines all data points in a given
octave and displays a total energy value for each octave band (as opposed to a linear
or logarithmic narrowband displays that plot the value of individual FFT data points).
Standard octaves are centered on 16, 31.5, 63, 125, 250, 500 (et al.) Hertz.
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Overlap: For the purposes of SIA-Smaart, overlap refers to the amount of data
each successive FFT Frame shares in common with the one before. Overlapping FFT
frames are analogous to shingles on a roof. When overlap is set to zero, each new
FFT frame begins where the last one stopped, like beads on a string.

Parametric Equalizer: Equalizers are devices with one or more filters that affect
the frequency content of a signal. On a parametric equalizers, the parameters of the
filter(s) including gain or attenuation, frequency and bandwidth are user-adjustable.

Phase Shift: A timing difference in a signal (relative to some reference) at one or
more frequencies, typically expressed in degrees.

Pink Noise: A random (or pseudorandom) signal in which, over a given averaging
period, each Octave-band has an equal amount of energy

Propagation Delay: The time it takes for sound to travel from one place (typically a
loudspeaker) to another place (typically a microphone).

Reverberation Time: The amount of time required for audio energy introduced into a
system (typically a room) to diminish, or decay a specified number of decibels. Often
expressed as an RT60 value.

RT60: Reverberation time. The amount of time required for a system, typically a
room, to decay 60 decibels. (see Decay Rate)

Sampling Rate: The number of points per second used in the analog to digital
conversion process. Typically expressed in Hertz.

Spectrograph: A three-dimensional plot, displayed in two dimensions with color
representing the third dimension (or z-axis). The spectrograph is a topographical
representation of the common waterfall display.

Spectrum: The frequency content of a given signal.

Speed of Sound: The speed of sound is dependent on the material of propagation,
the temperature and several other factors. Typical values for the speed of sound in air
are 1120 ft/sec, or 341.376 m/sec. This is the default value SIA-Smaart program
modules use to calculate distance equivalents for time differences.

White Noise: A random (or pseudorandom) signal in which over a given averaging
period, each frequency has equal energy.
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Installation Issues

SIA-Smaart Acoustic Tools is written for use with Microsoft Windows. It is a native
32-bit Windows application. The installation program will not run from the DOS
prompt. (See Section 1: Getting Started for installation instructions.) Versions of
Microsoft Windows previous to Windows 95/NT 4.0 are not supported. Windows
must be running properly on your system before you can install or run this software.

A valid Serial Number and Install Name are required is required to install Smaart
Acoustic Tools. The serial number and install name are keyed to the product code

on your installation and will only work when installing from a CD with the identical
product code. Your Serial Number and Install Name and installation CD Product Code
are imprinted on the registration card included in each SIA-Smaart Acoustic Tools
software package. Please keep your registration card in a safe place. This information
may be required for you to receive technical support and product upgrades. Your
install codes will also be required if the program files on your hard disk are deleted or
corrupted and you need to reinstall the software for any other reason.

It is strongly recommended that you close all other Windows programs, including

any automatic anti-virus and/or system monitor software you have running, before
attempting to install this software. Antivirus programs in particular are known to
cause conflicts with the installer program and may prevent the software from properly
registering itself with the operating system. Installation problems related to other
software usually manifest themselves after a seemingly successful installation when
one or more of SIA-Smaart program module will not open. Shutting down all other
running programs and repeating the installation will usually correct this.

If you experience problems during the installation, for example, if the installer program
“hangs” or issues error messages before the installation process is completed, you
may have a defective or otherwise unreadable installation disk. If you experience
problems of this nature, contact SIA technical support for troubleshooting assistance.
Technical support contact information is listed at the end of this chapter.
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Computer Sound Hardware Issues

Windows-compatible sound hardware must be present and properly configured for
your system to use recording features in the SIA-Smaart Intelligibility and Analysis
modules. SIA-Smaart Acoustic Tools uses standard Windows Application Program-
ming Interface (API) calls to access the sound card and should work properly with
any 100% Windows-compatible audio device.

If the Intelligibility and/or Analysis modules will not recognize your sound hardware,
check to see if you can record and play back wave files using the Sound Recorder
and Media Player. These are standard Windows utilities, usually located in the
Accessories section of the Programs menu (accessed by clicking the Start button
on the Windows Taskbar).

If you cannot play and record using the Sound Recorder and/or the Media Player
will not recognize your sound hardware, check to make sure both the hardware
device and the software that came with it are properly installed. Sound hardware
setup typically requires loading software drivers and utilities in addition to any
hardware installation.

Depending on your system, the sound hardware driver software could be on a
diskette supplied with the sound card or computer, the Windows setup disk(s), or
both. Some sound cards also require the user to set jumpers or DIP switches on the
card itself before installation. If you have upgraded your system to a new version of
Windows from a previous version, you will probably need to obtain updated drivers
for your sound hardware from the sound card or computer manufacturer as well.

It is not uncommon for manufacturers to discover device driver software problems
after a card or computer ships. If you are sure your hardware and software drivers
are properly configured and you continue to experience problems, contact the sound
hardware or computer manufacturer. In many cases you can obtain updated driver
software that will correct the problem(s).

If your computer has more than one sound hardware and/or MIDI I/0 device or driver
set installed, make sure the proper devices are selected for both audio and MIDI 1/0 on
the Devices tab of the Options dialog box (accessible from the Options menu) in both
the Intelligibility and Analysis modules.
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Configuring Windows Audio Controls 4 728PM

Beginning in Windows 95, the Windows Volume Control application

provides a standardized interface for controlling the audio inputs and outputs of
many or most Windows compatible audio devices. If you have trouble getting a
signal into either SIA-Smaart Acoustic Tools program module from the computer’s
(line-in) inputs or suspect the computer’s internal microphone may be enabled and
contaminating your measurements, use the following procedure to access the
Record (input) controls.

* Open Volume Control — double-click the speaker icon (shown above) on the
Windows Taskbar or click the Start button and select Programs > Accessories >
Multimedia > Volume Control

* In the Volume Control application, select Properties from the Options menu.

* Click the Recording “radio button,” make sure the boxes for Microphone and
Line-In are checked in the list below, and click OK to exit the Properties dialog box.

Notice that the title of the Volume Control window changes to Recording Control.
Make sure the Select box for Line-In is checked, confirm that the balance control is
centered and the fader is set

to a useful level. If your computer is equipped with an internal microphone, it's a good
idea to also un-check the Select box under the Microphone fader before exiting the
Recording Control application.

Input Levels

It is important to maintain proper input signal levels when performing measurements
of all types. For best results you need a good strong signal that does not “light” the
Clip indicators above the meters. If the signal level is too low, you will get a poor
signal-to-noise ratio. If it is too high, the input(s) will overload causing “clipping.” This
will compromise the accuracy of your measurements and could damage your com-
puter. Overloading one input channel can also cause the other to behave erratically.

When using a test signal with a high “crest factor,” such as pink noise, transient
peaks in the signal may be too fast for the Input Level Meters to detect. \We recom-
mend keeping the overall input signal levels at about —12 dB for random noise and
MLS stimulus signals, and music.
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The Input Level Meters in the Intelligibility module Record Impulse dialog box and in
the Analysis module Record Wave File dialog indicate the input signal level at the
sound hardware’s A/D converter. A/D converter input voltage ranges vary. Some
sound cards allow you to set A/D input voltage levels using jumper settings or
software. Some do not. It is often desirable to use a mixer, microphone preamp or
other external device to control input levels.

If your computer has both microphone and line level inputs, be sure to avoid sending a
line level signal to a microphone input. As a rule, we recommend you avoid using the
microphone inputs. The quality of the preamp circuitry is typically very poor.

Problems With the Intelligibility Module Impulse Response Recorder

Poor Signal-to-Noise Ratio

If you do not see a clear peak in a new impulse response recorded in the Intelligibility
module (using either the MLS or Dual FFT method) and/or the “noise floor” of the
measurement is too high to see acoustical information about the room/system under
test, it may be helpful to increase the gain of the measurement microphone and/or
loudspeaker(s) used to stimulate the room. In reverberant spaces, the amplitude of
the peak is a function of the signal-to-noise ratio of the measurement signal.

Another way to increase the signal-to-noise ratio of both MLS or Dual FFT measure-
ments is to increase the number of averages by increasing the Averages value in the
Record Impulse dialog box. If this value is greater than 1, the Intelligibility module
records the specified number of FFT or MLS frames and averages the data from all
recorded frames in the impulse response calculation. Each doubling of the number of
frames averaged will yield 3 dB more signal to noise (down to the absolute noise floor
of the system under test or the measurement system, whichever is higher).

Insufficient Time Window

If the impulse measurement plot appears erratic, without a single strong peak and/or
with several peaks of nearly equal amplitude, the reason could be that the FFT or MLS
Time Constant is too short. Check to insure that the time constant is set to a value
larger than the decay time of the system under test and increase the FFT size/MLS
Length (or decrease the sampling rate) if necessary.

SIA-Smaart Acoustic Tools Version 4 User Guide Page 123



Appendix A: Troubleshooting

“Negative” Delays (Dual FFT Only)

An oddity of the Dual FFT impulse recorder mathematics causes “negative” delays to
be “wrapped around” and displayed at the end of the time scale. When this happens,
the strongest peak in the impulse response will show up closer to the end of the
measurement than the beginning, appearing to indicate an unbelievably long delay
time through the system under test.

There are two likely causes for this problem.
1. The computer input channels are wired incorrectly and need to be swapped.
2. There is a delay in the reference channel.

In the first case, swapping the inputs to the computer will correct the problem. In the
second case, you must either compensate for, or remove the delay in the reference
channel. To accomplish this, you could delay the measurement signal by an equal
amount (using an external delay device) or simply remove the device(s) introducing
delay from the reference signal path.

Digital signal processing devices are likely suspects for reference signal delay. For
example, many digital delay units introduce some delay, even when set to “bypass”
and/or indicating 0 ms delay time. This is called /atency or throughput delay. Other
types of digital audio devices may also introduce unwanted delay.

Printing Problems

Problems with printing from SIA-Smaart applications often turn out to be the fault of
incorrect, outdated or corrupt printer drivers. If you have printing problems, make sure
you have the correct Windows software driver for your printer properly installed and
configured. If necessary, reinstall the drivers from the Windows setup disk(s) or disk
supplied with your printer using the Windows Printers control panel. If problems

still persist, check the documentation that came with your printer for troubleshooting
help. You may need to contact your printers manufacturer to obtain an updated driver.
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Restoring the Default Configurations

User-definable options for the SIA-Smaart Acoustic tools program modules are very
flexible and can sometimes be confusing, especially at first. Both the Intelligibility and
Analysis modules store the state of nearly all of these options when you exit so if a
problem related to configuration does arise, chances are good that it will still be there
the next time you start the program.

Any time you wish to restore the Intelligibility module to its “factory” default settings,
select Set All Values to Default from the File menu. To reset the Analysis module to its
defaults, select Set All Options to Default from the Options menu. Resetting to defaults
changes virtually user-definable parameters for the program back to their original
states. The only exceptions are that the Color Scheme and audio input/output device
selections are left as set on the Colors and Devices tabs of the Options dialog box.

On-line Help and Readme Files

If you have a problem or question about SIA-Smaart Acoustic Tools and cannot find
the answer in this manual, check the on-line Help files and Readme file (if applicable).
The Help files, accessible from the Help menus of both the Intelligibility and Analysis
modules, may contain information not included in the manual. Your copy of Smaart
Acoustic Tools may also include a file called Readme.doc, located in the main
program folder, with additional information about the software. The default location
for the Acoustic Tools program folder is C:\Program Files\SIA-Smaart Acoustic Tools.

Technical Support

Support for SIA software products is available through our web site, by e-mail or by
telephone. On the SIA web site (www.siasoft.com), you can find Application Notes,
Case Studies and answers to frequently asked questions as well as product news,
updates, and an on-line web support forum. Maintenance updates, and information
of interest to SIA-Smaart users is posted on the web site as it becomes available.
For technical support via e-mail, the address is support(@siasoft.com. The telephone
number for SIA technical support (in the USA) is (+) 508 234-9877.
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Color Schemes 90
Colors 96
Commands 68
Compressors 115
Configuration 39, 73
Export 73
Import 73

Configuring Windows Audio Controls 122
Create Impulse From File 34, 36, 38, 39
Crosstalk 115
Cursor 85, 86, 87, 88, 89

Track Nearest Data Point 46

D

Data Window 115

Data Window Functions 107

Decay Rate 115

Decibel 116

Decibels 107

Default Zoom 87

Devices 48, 91

Devices Options 48

Direct to Reverb 13, 37

Direct to Reverberant Level 108

Dual FFT 15, 20, 34

Dual FFT Measurement Setup 20

Dual-FFT: Recording the Impulse Response 23
Dual-FFT: Setting Measurement Parameters 21
Dynamic Range 116

E

Early Decay Time 13, 37
Early Decay Time (EDT) 116
Energy Time Curve (ETC) 108
ETC 44, 108
Exit 74
External Hardware 3
Measurement Microphone 3
Mixer or other level adjustment device 3

F

Fast Fourier Transform (FFT) 109
FFT 15, 20, 34, 109, 116
FFT (size) 32
FFT Center Point 86

Clear 86

Move 86

Select/Change 101

Set FFT Center to Peak 85, 86
FFT Frame Selection 100
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FFT Time Constant 32
Figures
Dual FFT Measurement Setup
External Signal Source 21
Internal Signal Generator 20
MLS Measurement Setup 18
Pink Noise 113
File 2
Move Left 84
Move Left Fast 84
Move Right 84
Move Right Fast 84
Reset to No Shift 84
File 2 On Top 84
File Info 69
File Menu
All Bands Table 38
Create Impulse From File 34
Open 29
Print 39
Print Preview 40, 74
Print Setup 40, 74
Save As 29
Set All Values to Default 39
Filters 25, 46
About 25
Finding Time and Amplitude Differences 24
Frames 97
Frequency (Y) Scale 97
Frequency Masking 102
Frequency Resolution 109
Frequency Slice 62, 77, 95
Power Spectrum 93, 94
Frequency Zooms 91

G

Getting Started 1
System Hardware 1
About Sound Hardware 1
Minimum Configuration 1
Recommended Configuration 1
Glossary of Terms 115
Graph Options 49

Impulse Qutput File 32, 33
Impulse Response 15, 17, 20, 34, 110
Calculating Intelligibility from 10
Create From File 34
Input Levels 50
Installation 4
Intelligibility 10, 13, 38
All Bands Table 38
Calculating from an Impulse Response 10
Graph 13
Intelligibility (Jump to) 70
Intelligibility Graph 13, 36, 38, 39
Intelligibility Graph Command 36, 38, 39
Intelligibility Module
Commands. See Intelligibility Module
Commands
Intelligibility Module Commands 29
File Menu (Intelligibility Module) 29
All Bands Table 38
Create Impulse From File 34, 36, 38, 39
Intelligibility Graph 36, 38, 39
Print 39
Print Preview 39, 40, 73, 74
Print Setup 39, 40, 73, 74
Record Impulse 30
Save As 29, 30, 31, 34, 36, 38, 39
Set All Values to Default 39
Options Menu (Intelligibility Module) 47
Color 47
Devices 48
Graph 49
Meter 50
Printing 52
View Menu (Intelligibility Module) 31
1/3 Octave Band Filters 46
Amplitude 43
Channel 46
Marker (Ld, Lr, Ln) 45, 46
Octave Band Filters 46
Show 43, 44, 45, 46
Track Nearest Data Point 46
Zoom 41
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Intelligibility Module Filters 25
Intelligibility Module Functions 10
Calculating Intelligibility 10
Filters 25
Intelligibility Graph 13
Positioning the Ld, Lr, and Ln Markers 25
Recording an Impulse Response 15
Zooming With the Mouse 25
Intelligibility Module Window 6

J
Jumping to Other Programs 9, 26

K

Keyboard Shortcuts
Analysis Module 104
Intelligibility Module 53

L

Latency 116

LdLrand Ln 10

Led Levels 93

Linear & Logarithmic Scales 111
Linear and Logarithmic Scales 111
Linear Scale 116

Links to Other Programs 9, 26
Logarithmic Scale 116

Loop Through Slices 81

Loopback 33

Magnitude 116
Making a Screen Capture 28
Marker (Ld Lr Ln) 45
Mask 83, 84
Clear Mask 84
Maximum Length Sequence (MLS) 111
Measurement Channel 34
Measurement Microphone 3
Measurement Setup Diagram
Dual FFT
External Signal Source 21
Internal Signal Generator 20

MLS 18
Menu Bar 7
Meter Options 50
Meters 92
Minimum Configuration 1
Mixer or other level adjustment device 3
MLS 15, 17, 34, 111
MLS Length 34
MLS Measurement Setup 18
MLS Signal Generator 33
MLS: Recording the Impulse Response 20
MLS: Setting Measurement Parameters 18
Mouse Procedures 100
Move FFT Center Left 86
Move FFT Center Right 86
Move Range Left/Right 42
Move Range Up/Down 42
Move Up/Down 80

Next Slice 81
Normalized 88
Nyquist Frequency 116

0

Octave / 1/3 Octave Band Filters 46
Octave Band Filters 46
Octave-Band Resolution 112, 116, 117
Open 29
Open File 1 68
Open File 2 68
Options. See Options Menu Commands
Options dialog box 89
Options Menu
All 47, 48, 49, 50, 52
Color 47
Devices 48
Graph 49
Meter 50
Printing 52
Overlap 117
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P

Parametric Equalizer 117
Phase Shift 117
Pink and White Noise 112
Pink Noise 117
Pink Noise Generator 31
Plot Title 49
Positioning the Ld, Lr, and Ln Markers 24
Power Spectrum 63, 88, 93, 94
Print 39, 73
Print Command 73
Print Preview 39, 40, 73, 74
Print Setup 40, 74
Printing 39, 40, 52, 74, 93
Print Command 39
Print Preview 40, 74
Print Setup 40, 74
Printing Options 52, 93
Printing Problems 124
Propagation Delay 117

Rainbow 87
Rainbow Display
Normalized 88
Range 25, 41, 42, 43, 49
Recommended Configuration 1
Record Impulse 30
Recording 15, 17, 20
Recording an Impulse Response 15
Recording an Impulse Response Using Dual FFT
20
Recording an Impulse Response Using MLS 17
Recording the Impulse Response
Dual-FFT 23
MLS 20
Reference Channel 33
Reset to No Shift 84
Restoring the Default Configurations 125
Reverberation Time 117
RSTI 13
RT60 13, 36, 117

S

Sampling Rate 113, 117
sampling rate 19, 22, 32, 34
Save As 29
Save Difference As 70, 71
Save Filter Data in Memory 50
Save Wave Zoom As 70, 71
Scale 25, 41, 42, 43, 46, 49
Schroeder On Top 44, 46
Schroeder Reverse Time Integration 113
Schroeder Trace 43, 44, 46
Screen Capture 28
Screen shots 28
Select/Change (First) FFT Center to Peak 101
Select/Change Normalization Point 101
Selected Bibliography 118
Selecting Sound Hardware 48
Set All Options to Default 99
Set All Values to Default 39, 99, 125
Set FFT Center to Peak 85, 86
Setting Measurement Parameters
Dual-FFT 21
MLS 18
Setting FFT Center Point Using Your Mouse 86
Shift Up/Down 85, 86
Shortcuts
Keyboard 53, 104
Show 89
ETC 44
Schroeder On Top 44
Schroeder Trace 43
Slice 81, 95
Sound Hardware, About 1
Spectrogram: 117
Spectrograph 64
Spectrum 117
Speech Transmission Index (STI, RSTI) 113
Speed of Sound 49, 98, 117
SR 32, 34
STI 13, 37
System Hardware 1
Minimum Configuration 1
Recommended Configuration 1
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Technical Support 125

Time Constant 32, 34

Time Display 59
Options 98, 99

Time Range 49

Time Range Selection 101

Time Slice 60, 95

Time Zoom 78

Track Nearest Data Point 46

Transfer Function 114

Transform 71

Troubleshooting 120
Input Levels 122
Installation Issues 120
Printing Problems 124
Sound Cards 121
Technical Support 125

U

Undo/Redo Zoom 41
Use Loopback For Time Alignment 33
Use Mask 83

vV

View Menu. See Analysis Module
Commands; Intelligibility Module Com-
mands

W

Wave-In 48, 91

Bits Per Sample 48
Wave-Out 48, 91

Bits Per Sample 48
Waveform Display

Options 99
White Noise 117
Window Elements 7

Menu Bar 7
Windows Audio Controls 122

X
X Zoom 17

Y
Y Zoom 42, 43

z

z-axis 46
z-order 44, 46, 87
Zoom 25, 41, 42, 43
Move Range Down 42
Move Range Left 42
Move Range Right 42
Move Range Up 42
Redo 41
Undo 41
Zoom Out To Limits 41
Zoom X In 41
Zoom X Out 41
ZoomYIn 42
Zoom Y Qut 42
Zoom In/Out 79
Zoom Out To Limits 41
Zoom X In/Out 41
Zoom Y In/Out 42
Zooming With the Mouse 25
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